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Chapter 1: Introduction
Heating, ventilation, and air conditioning (HVAC) systems are estimated to
comprise roughly 44% (3.1 Quad) of commercial building energy usage in the United
States, representing a significant source of costs and carbon emissions [1], [2]. Due to
increasing concerns of the negative health effects from inadequate air circulation, new
building regulations have been developed requiring increased air turnover, which can
result in increased energy consumption costs [2], [3]. To mitigate these concerns,
energy recovery ventilators (ERVs) are a promising solution for significantly reducing
building energy consumption in buildings. These devices are heat-and-moisture
exchangers which can complement building HVAC systems to reduce HVAC energy
consumption by pre-conditioning incoming air using building air exhaust [4], [5], [6],
[7], [8].
While many ERV systems exist which specialize in either pure sensible heat
transfer or combined sensible and latent heat transfer, the three most common systems
capable of both heat and moisture transfer are membrane-based plate exchangers,
rotary desiccant-coated energy wheels, and certain types of liquid desiccant systems
[2], [6], [7], [8]. In particular, membrane-based plate exchangers are attractive for
widespread implementation due to the simplicity of their design, which lack the energy
and maintenance requirements of rotary energy wheels and the corrosive fluids found
in many liquid desiccant systems. In the membrane-based approach, arrays of channels
are produced from thin selectively permeable membranes, such that heat and moisture
exchange occurs between incoming and exhaust air streams [9], [10], [4], [5]. During
the winter, these ERVs transfer excess moisture and sensible heat from the building
exhaust through the membrane and into the incoming outdoor airstream, with this
process reversing in the summer [2], [10], [4], [5], [9]. Although efficiency is the
greatest when these channels are placed in counter-flow arrangement [11], most
membrane-based ERVs use a cross-flow design due to space limitations and ease of
integration within building ductwork, as well as ease of fabrication [4], [9].
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Despite the attractive traits of membrane-based ERVs, several design and
manufacturing challenges remain which hinder implementation of these ERVs in many
potential building HVAC systems. Currently, most membrane-based ERV designs
have limited performance due to limited membrane moisture permeability, thus
requiring many years for the cost savings to offset initial investment into such devices
[4], [5]. Furthermore, an evaluation of the costs associated with installing membranebased ERVs shows that cost is driven by installation, suggesting the need to improve
throughput per ERV in hopes of reducing the number of installations per site. It is
hence desirable that more efficient designs are developed capable of greater air
processing rate per unit volume [2]. Although recent work has shown that channel size
reduction in membrane-based ERVs is associated with a significant improvement in
mass transfer rates, efficiency below a critical channel size is inherently limited by
membrane mass transfer resistance [2]. Because thinner membranes are associated
with reduced mass transfer resistance [9], [4], [2], new ERV designs increasingly make
use of thinner membranes. However, thinner membranes are easier to deflect into the
channels during ERV operation due to pressure differentials, resulting in reduced
overall device performance [12]. It is generally accepted that for microchannel heat
exchangers, channel variability must be constrained to no more than 5% of the nominal
dimensions to avoid loss in thermal effectiveness and efficiency [12].
One way to minimize membrane deflection is by pre-tensioning membranes
prior to ERV operation [9], [13]. However, this is difficult to implement, requiring
additional fixturing components which would increase the size of the ERV. Another
method for minimizing membrane deflection is by stiffening the membranes through
corrugation [2], [5], [14], [15]. However, as membrane thickness decreases, many
corrugated membranes still require secondary support structures [5], [14]. So, more
commonly, an internal support structure in the form of spacers [16], [9] or ribs [2] are
placed within the device to decrease the unsupported span of the membrane. As
membranes reduce in thickness, more support structures are needed which reduce the
membrane area used for heat and mass transfer i.e. the membrane open area. In order
to maximize the membrane open area, it is desirable that support structures be as narrow
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as possible, driving support structures toward higher height-to-width aspect ratios. In
this paper, our objective is to introduce a cost-effective channel lamination method
capable of scaling the high aspect-ratio support ribs necessary for emerging membranebased ERV designs.
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Chapter 2: Manufacturing Process Design
This section is organized based on previous work in manufacturing process
design (MPD). Below, various membrane-based channel lamination methods are
discussed and a conceptual design of the new process is proposed. Next, a detailed
design is described for meeting the process requirements based on a set of market
conditions. This design specifies a manufacturing process flow and the associated
equipment to meet those requirements. The design is evaluated using the estimated
unit cost based on building a greenfield site [17], [18].
Numerous approaches to the fabrication of membrane-based channel arrays are
described in the literature.

Typically, these fabrication approaches focus on

microchannel arrays, constructed by bonding membranes between stiff laminae, which
are patterned with channel features using micromilling, photochemical machining
(PCM), or hot embossing [19], [20], [21], [22], [23], [24]. PCM can only be used on
metallic laminae. Sealing of the array is done by various means. In hemodialysis
applications, the membrane is compressed to achieve a gasketed hermetic seal between
the laminae and membranes [22], [19]. To overcome sealing pressure and geometric
tolerance limitations, other studies have introduced the concept of placing sealing boss
features on the patterned laminae [20], [24], [23]. These bosses relax the flatness and
parallelism tolerances required to achieve good sealing, and concentrate the clamping
pressure onto localized regions near channel edges, allowing the resulting seals to
withstand greater fluid pressures [20]. However, in compression sealing, pressure must
be continuously maintained throughout the channel array to maintain the gasketed
seals, requiring fixture components [24]. Alternatively, transmission laser welding has
been used for bonding purification membranes to patterned laminae within a
microfluidic assembly [21]. However, all of these techniques require the use of
patterned laminae between each active membrane layer, representing an increase in
material and processing costs [12], [25].
To reduce the costs of channel lamination, surface mount technology (SMT)
has been explored to shorten cycle times and reduce assembly steps [25]. In SMT,

5

electronic components are attached to a printed circuit board, using a solder paste or
viscous non-slump adhesive.

Solder-based SMT has been demonstrated for the

lamination of patterned copper shims [25], although these methods are not compatible
with thin polymer membranes. Alternatively, surface mount adhesives are particularly
attractive for bonding membranes because they are designed to resist slumping so that
precise structural features can be deposited and cured at relatively low temperatures
[26]. Although prior efforts have explored the use of surface mount adhesives for
channel lamination [26], [27], these approaches have not taken advantage of the nonslump behavior of surface mount adhesives, instead requiring an extra patterned
laminae to define channel dimensions. Below, surface mount adhesives are deposited
onto a membrane, bonded to an adjacent membrane and then stretched to produce high
aspect ratio structural features capable of meeting the requirements for producing an
ERV with thin membranes.

2.1 Process Requirements
Process requirements included specification of materials and geometry as
proposed within a recent membrane-based ERV design designed to be installed within
the exterior walls of buildings [2]. The full – scale design is shown in Fig. 1 consisting
of a laminated stack of polymeric membranes separated by cured adhesive ribs as
shown in Fig. 2. This membrane is composed of a 26 μm (± 2.7 μm) porous
polypropylene film with a 1 μm sulfonated PEEK coating on one side. This coating
was designed to inhibit microbial growth on the outside air side of the membrane
requiring every other layer to be flipped in order that the PEEK coating was oriented
to the outside air stream. The membrane was known to be sensitive to UV-radiation
ruling out the use of UV-curable adhesives. Additionally, it could not experience a
bulk temperature greater than 80 °C or localized temperatures greater than 150 °C
which constrained thermal curing.
The adhesive ribs had the dual function of maintaining channel dimensions
while imparting bond strength to ensure complete hermeticity under operational loads.
Rib patterns were arranged on each layer as a series of parallel rows with two 45 degree
bends to accommodate triangular header regions. As shown in Fig. 2, this rib pattern
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was mirrored from layer-to-layer resulting in two triangular cross-flow headers on
either end of the ERV, which enabled connection to internal and external air streams,
and were designed to distribute flow evenly between ERV channels. Critical
engineering specifications for this design are listed in Table 1. Regarding channel
height tolerances, as noted previously, prior work has shown that channel height
variation should be constrained to no more than 5% [12]. Consequently, both the
difference between the mean height and the specification as well as the standard
deviation of the mean height were set to 5%. Based on these criteria, a set of
manufacturing process requirements were derived as summarized in Table 2.

Figure 1 – Orthographic projections of overall ERV geometry. All dimensions are in
mm.
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a)

b)

Lamina A

Lamina B
Figure 2 – a) Top view of ERV lamina, with exposed mirrored adhesive rib patterns;
b) Cross-section of body rib pattern with a close-up showing ideal rib dimensions. All
dimensions are in mm.
Table 1 – Membrane-based ERV Engineering Specifications
Specification
Total length, 𝐿
Total width, 𝑊
Total height, 𝐻
Number of layers per ERV core, 𝑁𝐿
Number of ribs per layer, 𝑁𝑟𝑜𝑤𝑠
Target channel height, ℎ𝑡𝑎𝑟𝑔𝑒𝑡
Target rib height:width aspect ratio, 𝐴𝑅𝑡𝑎𝑟𝑔𝑒𝑡
Rib pitch
Nominal membrane thickness, ℎ𝑚𝑒𝑚
Pressure drop
Latent effectiveness
Sensible effectiveness
Air processing capacity, 𝑉̇

Value
700 mm
175 mm
849.11 mm
692
28
1.2 mm (± 0.060 mm)
1.25*
6.43 mm**
0.027 mm
≤ 300 Pa
> 83 %
> 90 %
300 cfm

Yields a target rib width of 0.96 mm
** Yields an edge – to –edge rib spacing of 5.47 mm

8

Table 2 - Manufacturing process requirements
Metric
Mean channel height, 𝜇ℎ
Channel height standard deviation, 𝜎ℎ
Mean rib height:width aspect ratio, 𝜇𝐴𝑅
Peel strength, 𝑆
Cost at production volume, 𝐶𝑂𝐺𝑆
Annual Production Volume, 𝑃

Target
1.2 mm
0.06 mm
1.25
1 mN/mm
2100 USD/ERV Core
5000 ERV Cores / Year

2.2 Manufacturing Process Flow Diagram
Based on the design specifications and derived process requirements, we
developed a simple manufacturing process flow diagram using the previously
introduced surface mount adhesive – based membrane lamination method. This is
shown in the process flow diagram of Fig. 3.

Figure 3 - Process flow diagram
As this diagram illustrates, raw material consisting of membrane and non-slump
adhesive would be purchased and fed into the ERV assembly process. Within the
assembly process, each layer of the ERV would be assembled through separate
deposition, bonding, and curing process steps. In the deposition step, adhesive is
deposited onto a pre-cut membrane substrate along the lamina rib pattern according to
Fig. 2. Then, in the bonding process step a membrane is laminated onto the top of the
deposited adhesive bead pattern, forming an array of parallel channels bounded by
adhesive ribs. To ensure that each resulting adhesive rib is deformed according to the
dimensional process requirements, a novel combined compression – draw technique is
used in this process in which a membrane layer is first compressed onto the deposited
adhesive beads to establish tack, followed by stretching of the now bonded membrane
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– adhesive assembly to the target rib dimensions. In the final curing process step, the
laminated layer is exposed to a source of energy or curing agent to “lock” the resulting
layer rib dimensions in place and prevent the ribs from further plastically deforming
during subsequent bonding load cycles. To assemble all layers of the ERV design, this
process step sequence (deposition, bonding, and curing) would be repeated 692 times
until the full ERV core is assembled, at which point the core would be packaged and
shipped.

2.3 Manufacturing Process Step Analysis
Prior to further analysis, an initial cycle time analysis was used to determine the
maximum allowable cycle time for a given production process step based on the
process flow shown in Fig. 3. The result of this analysis derives from several
assumptions. First, based on targets set by an industry partner, the initial annual
production volume for the ERV core design was estimated to be 5,000 ERV cores per
year with no more than 7 dedicated machine tools for layer assembly during initial
manufacturing process scale up. Here, each layer assembly tool represents an integrated
carousel assembly of deposition, bonding, and curing process step workstations such
that three ERV cores are manufactured simultaneously, with an estimated part
movement time 𝑡𝑚 of 5 seconds between each workstation and a common takt time
𝑡𝑡𝑎𝑘𝑡 between the start of each process step. Additionally, production was estimated to
occur for 24 hours a day, 343 days a year, yielding a required hourly production rate of
approximately 0.61 cores per hour, or approximately 420 layers per hour. Assuming a
95% ERV core yield after inspection and 95% tool utilization, we determined 54
seconds as the required takt time 𝑡𝑡𝑎𝑘𝑡,𝑟𝑒𝑞 . For more details on the integrated carousel
tool design and calculation of 𝑡𝑡𝑎𝑘𝑡,𝑟𝑒𝑞 , see Appendix A.
After determination of the required takt time, a detailed analysis was performed
to determine the required machine tools for each process step and a set of material
requirements for optimal adhesive selection. The specified parameters from this
process step analysis which were used for process cost modeling and machine tool
capability evaluation are summarized in Table 3.
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Table 3 - Process step parameters determined after integration into a single carousel
machine tool.
Parameter
Nozzles per dispensing tool, 𝑁𝑛𝑜𝑧

Value
5

Parameter
Annual carousel tool operation duration, 𝑘

Value
8232 hrs

Dispense scan speed, 𝑣𝑠
Initial platen start height, ℎ𝑠𝑡𝑎𝑟𝑡,𝑝
Initial platen compression height, ℎ𝑐𝑜𝑚𝑝,𝑝
Platen compression speed, 𝑣𝑐𝑜𝑚𝑝,𝑝
Initial platen draw height, ℎ𝑑𝑟𝑎𝑤,𝑝
Platen draw speed, 𝑣𝑑𝑟𝑎𝑤,𝑝
Draw dwell time, 𝑡𝑑𝑤𝑒𝑙𝑙
Vacuum release time, 𝑡𝑟𝑒𝑙𝑒𝑎𝑠𝑒
Platen return speed, 𝑣𝑟𝑒𝑡𝑢𝑟𝑛,𝑝
Initial platen end height, ℎ𝑒𝑛𝑑,𝑝
Curing process time, 𝑡𝑐𝑢𝑟𝑒

250 mm/s
30 mm
1 mm
240 mm/min
1.554 mm
15 mm/min
14 sec
3 sec
600 mm/min
30 mm
49 sec

Cumulative ERV yield, 𝑌
Carousel tool utilization, 𝑢
Carousel tool capital cost, 𝐶𝑡𝑜𝑜𝑙
Carousel tool installation cost, 𝐶𝑖𝑛𝑠𝑡𝑎𝑙𝑙𝑎𝑡𝑖𝑜𝑛
Carousel tool lifetime, 𝑡𝑗
Actual carousel tool footprint, 𝑆𝑡𝑜𝑜𝑙_𝑎𝑐𝑡
Hourly electricity usage per carousel tool, 𝑛𝐸
Nozzle cost, 𝐶𝑛𝑜𝑧
Nozzle consumption rate, 𝑟𝑛𝑜𝑧
Carousel movement time, 𝑡𝑚

95%
95%
1,770,000 USD
18,000 USD
20 yr
11.89 m2
195 kWh
10 USD/Nozzle
1 Nozzle/day
5 sec

2.3.1 Dispensing
Step analysis of the dispensing process began with a specification of the
machine tool capability requirements. Overall, these requirements included the need
to accommodate the ERV core footprint (700 mm x 175 mm) and deposit the entire
target adhesive layer pattern, while minimizing the resulting bead profile dimensional
variability over each layer of the ERV core. It was determined that mechanical strain
would be best minimized by matching the scan speed to the speed of adhesive exiting
the nozzle in a dispense process, resulting in a bead with the same diameter as the
nozzle. This implied that for a given dispensing tool, the maximum practically
achievable scan speed was constrained by the maximum achievable volumetric
dispense flow rate per nozzle and the nozzle diameter. While both displacement and
pressure-based approaches exist for driving adhesive flow from a dispenser nozzle [28],
[29], to maximize volumetric flow rate and scan speed, a displacement-based dispenser
with a progressive cavity driven pump was chosen. This is because it is much easier to
increase flow rates using motors in displacement-based systems than to increase input
pressure, especially if the tool components are only rated to withstand certain fluid
pressures. Based on this, it was determined that a maximum scan speed of 250 mm/s
was possible.
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At the same time, the dispense scan speed was also constrained by the takt time.
Assuming the uncontrolled moves between nozzle positions is negligible and no dwell
time exists at the start and stop of the adhesive beads, the estimated overall dispensing
process time was calculated according to Eqn. 1
𝑊

𝑡𝑑𝑖𝑠𝑝 =

𝑁

( √2+𝐿−𝑊)∗⌈ 𝑟𝑜𝑤𝑠 ⌉
2
𝑁𝑛𝑜𝑧
𝑣𝑠

(1)

where 𝑁𝑛𝑜𝑧 represents the number of nozzles per dispensing tool, ⌈ ⌉ represents the
ceiling step function, 𝑣𝑠 represents the single nozzle scan speed. All other variables are
as defined in Table 1. Calculations from Eqn. 1 indicate that to enable a takt time of
54 seconds with the 250 mm/s nozzle scan speed, a dispense tool with 2 nozzles was
required.

Based on conversations with equipment vendors, the final dispensing

machine tool specification was an integrated system consisting of a progressive cavitydriven pump with 5 nozzles attached to a robotic end effector for capable of a 250
mm/second scan speed.

This results in an estimated dispense process time of

approximately 16 seconds, well within the 54 second required takt time even when part
movement time is considered. Because the ERV core continually grows with each new
layer, the tool will ideally need to detect the top of the ERV core membrane prior to
dispensing. Other parameters determined for this tool after integration into the carousel
assembly are described in Table 3.
In addition to the maximum cycle time being constrained by the required takt
time, the dispensing process time is also constrained by adhesive material properties.
Since many adhesives become less tacky over time due to curing or drying in ambient
air, the dispensing process time must be short enough to ensure that the entire dispensed
adhesive layer remains sufficiently tacky by the time the adherent membrane is
laminated in the subsequent bonding process step. Otherwise the manufacturing
process will fail to form hermetic channels and result in an effective peel strength of 0
mN/mm. This is captured in the form of an anticipated in-process material property
requirement as shown in Eqn. 2.
𝑡𝑡𝑓,𝑚𝑒𝑎𝑠𝑢𝑟𝑒𝑑 ≥ 𝑡𝑜𝑝𝑒𝑛,𝐿

(2)
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Here, 𝑡𝑡𝑓,𝑚𝑒𝑎𝑠𝑢𝑟𝑒𝑑 represents the measured adhesive tack-free time, or experimentally
observed critical ambient air exposure time required for the formation of a non-tacky
cured surface skin on a one-part adhesive. Likewise, 𝑡𝑜𝑝𝑒𝑛,𝐿 represents the layer open
time, or the maximum amount of time that any portion in a layer’s adhesive dispense
pattern is exposed to ambient atmosphere prior to lamination of a membrane onto the
top of the adhesive layer. Note that 𝑡𝑜𝑝𝑒𝑛,𝐿 is a function of both the dispensing cycle
time and part of the bonding cycle time. For more details on the definition and
calculation of layer open time, see Appendix B. This in-process requirement, like the
others, describes the relationship between the process cycle time and adhesive
properties and serves as the basis for selecting an adhesive for optimal process control.
In addition to the requirement implied by Eqn. 2, the dispensing process step
has several other material requirements which were used to drive adhesive selection.
First, the selected adhesive needed to have a non-slumping rheological behavior, i.e.
lack of creep under its own weight after being deposited. Second, the selected adhesive
had to be capable of wetting and sticking to the membrane substrate during the
deposition process without the presence of a solvent. Third, the adhesive needed to be
deposited at relatively low temperatures such that the membrane remained below
150 °C (locally for a short time) to avoid thermal membrane damage.

2.3.2 Bonding and Stretching
In the bonding and stretching process step, two main required capabilities drove
the machine tool specification. Here, we assumed that the carousel tool operator would
manually load a new pre-cut membrane onto the bonding tool end-effector after each
bonding process step.

First, the tool needed a large enough work envelope to

accommodate the entire ERV core footprint of 700 mm x 175 mm. Second, the bonding
tool required the capability to accurately and precisely deform the adhesive beads to
the target height for each layer of the ERV core while under anticipated bonding loads.
One major challenge in achieving this is that after stretching, the adhesive requires
stress relaxation prior to letting go so to hold the desired dimension. To counteract
these relaxation loads, the bonding tool end-effectors required the ability to exert tensile
vacuum force evenly across all bonds at a level at least as great as the relaxation force.
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Additionally, because the height of the ERV grows with each new layer, the tool
requires the ability to reference the top of the stack.
Based on these criteria, a vacuum chuck platen was placed on the end of a linear
actuator with a minimum range of motion of 700 mm (in validation experiments, the
height of stack was constrained to 75 mm by the dispensing step). The linear actuator
would require an accuracy and precision within 60 μm and the ability to adjust platen
parallelism relative to the workholder stage. The vacuum chuck was constructed from
a stiff open-pore material to enable even distribution of the vacuum load. The full
bonding sequence involved gripping the incoming membrane, placing it on the top of
the stack for an initial tack, stretching of the adhesive to the final channel height,
holding for adhesive relaxation, releasing the membrane and returning the vacuum
chuck to the starting position. This process is conceptually depicted in Fig. 4. For
more details on the bonding process, see Appendix C.

Figure 4 - Diagrams of single layer bonding process a) start position b) compression
sub-step end position, c) draw sub-step end position / draw dwell sub-step position, d)
vacuum release sub-step position, and e) platen return sub-step end position. Yellow
arrows in represent external force imposed on the adhesive bond. Note that external
force on the bond disappears after vacuum load is released between sub-step c) and
d).
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For the purpose of this study, the bonding cycle time, 𝑡𝑏𝑜𝑛𝑑 , was calculated as
follows:
𝑡𝑏𝑜𝑛𝑑 =

ℎ𝑠𝑡𝑎𝑟𝑡,𝑝 −ℎ𝑐𝑜𝑚𝑝,𝑝
𝑣𝑐𝑜𝑚𝑝,𝑝

+

ℎ𝑑𝑟𝑎𝑤,𝑝 −ℎ𝑐𝑜𝑚𝑝,𝑝
𝑣𝑑𝑟𝑎𝑤,𝑝

+ 𝑡𝑑𝑤𝑒𝑙𝑙 + 𝑡𝑟𝑒𝑙𝑒𝑎𝑠𝑒 +

ℎ𝑒𝑛𝑑,𝑝 −ℎ𝑑𝑟𝑎𝑤,𝑝
𝑣𝑟𝑒𝑡𝑢𝑟𝑛,𝑝

(3)

where all key parameters in Eqn. 3 are specified according to Table 3. This calculation
assumes that the platen motion is along one axis.
Based on these parameters, Eqn. 3 yields a bonding process time of
approximately 29 seconds, and thus the specified bonding tool and parameters was
capable of meeting the 54 second required takt time even when a 5 second movement
time was added. In order to be conservative, the tooling capital and installation costs,
actual tool footprint, utilities, and estimated life time for this tool were made to be the
same as the dispensing tool, which was anticipated to dominate these categories. This
contributes to the integrated carousel tool parameters in Table 3.
In addition to the maximum cycle time being constrained by the required takt
time, the bonding process time was also constrained by adhesive material properties.
As previously described, the target draw position must be held for the fixed duration
𝑡𝑑𝑤𝑒𝑙𝑙 (see Table 3) to allow the adhesive to relax, hence:
𝑡𝑟𝑒𝑙𝑎𝑥 ≤ 𝑡𝑑𝑤𝑒𝑙𝑙

(4)

This anticipated in-process material requirement defines a second relationship between
the process cycle time and adhesive properties which drives optimal process control.

2.3.3 Curing
In the curing process step there were several capability requirements driving
machine tool specification. First the tool needed a large enough work envelope to
accommodate the ERV core footprint (700 mm x 175 mm). Second, the tool required
the ability to cure the entire top bonded layer to the point that its adhesive bonds are
stiff and elastic enough to resist cumulative plastic deformation upon subsequent
bonding cycles. Third, any energy source used in the curing process must not expose
the membrane to UV radiation or temperatures above 80 °C, as either may damage the
membrane. Finally, the curing tool must not induce plastic deformation within the
bonded layers of the ERV core. From a physiochemical perspective, during curing the
formation of crosslinks within the adhesive bond causes the material to transition
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between the uncured soft state to the cured stiff and elastic state, and the formation of
crosslinks at the adhesive – membrane interface causes the development of peel bond
strength. These reactions are accelerated by increased temperature and exposure to
increased reactant concentrations (e.g. atmospheric humidity, oxygen, etc…). At the
adhesive – membrane interface the strength of the crosslinks and hence peel strength is
dependent on the membrane surface chemistry; i.e. whether the coated or uncoated side
of the membrane is in direct contact with the adhesive. Because of these phenomena,
any curing process must ramp the adhesive temperature from the ambient temperature
to the target curing temperature in as short of a duration as possible to maximize the
degree of cure achieved. Additionally it must maintain a uniform temperature across
the entire top bonded ERV layer throughout the entire process duration. Based on these
criteria, an IR oven was chosen as the machine tool specification, under the conditions
that it is calibrated to produce no more than 5 °C of total temperature variation across
the entire ERV footprint and no more than 80 °C for all membrane layers during the
curing process duration. For the purposes of this MPD a curing process time 𝑡𝑐𝑢𝑟𝑒 of
49 seconds was specified to allow the maximum possible amount of heating within the
required 49 second takt time. Analogously to the bonding machine tool, it was assumed
that the tooling capital and installation costs, actual tool footprint, utilities, and
estimated life time for this tool were the same as the dispensing machine tool,
contributing to the integrated carousel tool parameters shown in Table 3.
As with both the dispensing and bonding process steps, the curing process time
is also constrained by adhesive material properties. In this case there is a required
adhesive curing rate for the adhesive to adequately cure by the end of the prescribed 49
second curing process time. To capture this requirement in the form of a constraint, we
define two new parameters: the layer cure time 𝑡𝑐𝑢𝑟𝑒,𝐿 , and the adhesive cure time
𝑡𝑐𝑢𝑟𝑒,𝑎𝑑ℎ . The layer cure time represents the amount of time between when the adhesive
is first dispensed and the start of the next layer’s bonding process, while the adhesive
cure time represents the minimum required layer cure time for which the adhesive is
stiff enough to resist cumulative plastic deformation upon repeated loading cycles. For
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more details on the definition and calculation of layer cure time, see Appendix B. Then,
a new in-process material requirement can be defined as Eqn. 5.
𝑡𝑐𝑢𝑟𝑒,𝑎𝑑ℎ ≤ 𝑡𝑐𝑢𝑟𝑒,𝐿

(5)

This requirement can also be understood as a comparison between the time that a given
adhesive must spend in the curing process versus the actual curing process time 𝑡𝑐𝑢𝑟𝑒
to ensure optimal repeatable process control. If the curing process time (49 seconds) is
shorter than the actual time the adhesive requires within this process (e.g. 2 min.), then
𝑡𝑐𝑢𝑟𝑒,𝑎𝑑ℎ ≥ 𝑡𝑐𝑢𝑟𝑒,𝐿 and the adhesive will be too soft and uncured by the time the next
bonding cycle occurs, causing plastic deformation of the bonded layer.

2.4 Adhesive Requirements
After the completion of all process step analyses, a complete set of adhesive
requirements could be specified. A summary of the adhesive requirements determined
during process step analysis are shown in Table 4. Note that in addition to the
previously discussed material requirements, two other material requirements were
added to account for possible causes of ERV performance degradation over time. For
instance, the selected adhesive should not experience structural degradation due to
moisture exposure throughout the ERV core’s anticipated lifetime, as this would reduce
overall ERV heat transfer effectiveness. Also, the cured adhesive should not foster
microbial growth under long term moisture exposure to avoid contaminating HVAC
supply air.
Based on the dispensing and bonding parameters, the values for each of the
anticipated in-process constraints on adhesive selection (𝑡𝑜𝑝𝑒𝑛,𝐿 , 𝑡𝑑𝑤𝑒𝑙𝑙 , and 𝑡𝑐𝑢𝑟𝑒,𝐿 ) in
Eqns. 2, 4 and 5 were calculated and inserted into Table 4 and are used in later
experimental design. The values for the 𝑡𝑜𝑝𝑒𝑛,𝐿 and 𝑡𝑐𝑢𝑟𝑒,𝐿 constraints are calculated
based on the formulae in Appendix B.
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Table 4 - Summary of in-process material requirements and selected adhesive
qualification. Green cells represent fully qualified adhesive material properties.
Yellow cells represent material properties which require experimental evaluation.
Description
Adhesive Dispense
Temperature
Adhesive Cure
Method
Presence of Solvent
in Adhesive
Adhesive Wetting
Behavior
Adhesive Moisture
Resistance
Adhesive AntiMicrobial
Resistance
Adhesive Tack-Free
Time

D*
Y

Category
B*
C*

Below 150 °C
Y

Adhesive should not be solvent – based

Y

Adhesive should wet the substrate membrane
during adhesive deposition
Adhesive bond strength and structure doesn’t
degrade under moisture

Y

Y

Y

Y

Y

Y

Adhesive
Relaxation Rate

Adhesive Curing
Rate

Non-UV energy source;
Global membrane temperature below 80 °C

Y

Adhesive Cured
Bond Strength
Adhesive Rheology

Requirement
P*

Y

Y

Y

Y

Y

Adhesive contains no nutrients for fungal /
bacterial growth

Dow Corning 3165 Fast Tack RTV
Adhesive Sealant
Room Temperature
1 – part atmospheric moisture cure;
Cure can be accelerated with increased
humidity or heat < 60 °C
No solvent
Can wet to porous PP & sulfonated PEEK
Bond strength and structural strength
increases with moisture (moisture promotes
cure)
Non-nutritive to microbial growth

Adhesive is tacky enough to wet to membrane
layers during the manufacturing process
(𝒕𝒕𝒇,𝒎𝒆𝒂𝒔𝒖𝒓𝒆𝒅 ≥ 61sec)

Reported Tack-Free Time at 25 °C: 5 min;
must be experimentally validated for our
process parameters

Peel bond strength after full cure is high enough
to resist the largest anticipated pressure
differential during ERV operation
Adhesive does not yield / creep under its own
weight (non-slumping)
Adhesive internal draw stresses relax fast
enough to enable dimensional process
requirements to be met, provided bonding
parameters are properly adjusted (𝒕𝒓𝒆𝒍𝒂𝒙 ≤ 14
sec)

Must be determined experimentally; only
lap shear strength reported (128 N/cm2)

Adhesive is able to cure to a sufficiently stiff /
elastic state to lock in bond dimensions by the
time of the next applied load (𝒕𝒄𝒖𝒓𝒆,𝒂𝒅𝒉 ≤ 208
sec)

Must be determined experimentally

Classified as “non-slump” adhesive
Must be determined experimentally

*D = Dispensing process step, B = Bonding process step, C = Curing process step, P
= Performance during ERV operation
As seen in Table 4, we determined Dow Corning 3165 Fast Tack RTV Adhesive
Sealant as a promising candidate for the proposed surface mount adhesive – based
manufacturing process based on the anticipated material requirements. This compound
is a one – part moisture curing adhesive sealant which cures by the growth of an elastic
minimally – tacky surface skin over time due to ambient air moisture exposure. Further
conversation with the vendor revealed that the rate of cured skin growth could be
accelerated with heat or increased atmospheric humidity, as long as the adhesive
remains below 60 °C. Additionally the cost for this adhesive was quoted as 5,635.91
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USD for one 220 kg drum, giving a volumetric cost of 0.035 USD/mL if the uncured
adhesive density is assumed to be the same as the given cured density of 1.35 g/mL
[30].
Due to the process dependence of certain material properties, a full qualification
of the adhesive was not possible from vendor provided information alone, as indicated
by the yellow cells. Evaluation of the four remaining requirements for the selected
adhesive will occur during MPD validation experiments and contribute to experimental
design.

2.5 Cost Model
Using the methodology introduced by Gao et al. [31], [32], a production cost
model was developed using Microsoft Excel 2016.

A custom Visual Basic for

Applications (VBA) function was also developed to verify that the MPD met the
production cost requirement of 2,100 USD/ERV core at the target annual production
volume, based on the assumptions in Table 1, 2, 3, and 5. For more details on the
assumptions used in this cost model, see Appendix D. An additional goal of these
model was to explore the effect of production scale – up on costs. Estimated COGS
was calculated at seven different annual production volumes to yield the production
cost curve as shown in Figure 5, with all other assumptions as previously described.
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a)

b)

c)
C:
11.9%

U: 3.2%

T:
21.0%
F: 0.3%

R:
25.0%

T: 6.1%
U: 6.6%

F: 0.1%
L: 5.1%
M:
6.0%

C:
24.6%

L:
17.6%
M:
20.8%

R:
51.6%

d)
U: 6.6%
C: 24.6%

T: 6.1%

F: 0.1%
L: 5.1%
M: 6.0%

R: 51.6%

Figure 5 – a) Estimated COGS as a function of ERV core annual production volume,
with the maximum allowable COGS shown as a green horizontal line, b) COGS
breakdown at 100 ERV cores per year, c) COGS breakdown at 5000 ERV cores per
year, and d) 10000 ERV cores per year. For all pie charts (cost per ERV): T =
tooling, F = facility, L = labor, M = maintenance, R = raw material, C = consumable,
and U = utility.
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Table 5 - Non process step specific cost model assumptions
Parameter
Required membrane conversion length
Required membrane conversion width
Cost of manufacturing space
Operator working space per carousel tool
Facility lifetime
Annual carousel tool operator salary
Loaded labor cost rate
Operators required per carousel tool
Maintenance cost as fraction of capital cost
Electricity cost
Adhesive cost
Raw membrane cost
Membrane conversion cost

Value (Carousel Tool)
720 mm
330.2 mm
1000 USD/m2
23.78 m2
25 yr
50,000 USD/yr
1.5
1 op/tool
5%
0.0672 USD/kWh
0.035 USD/mL
5 USD/m2
0.348 USD/ERV membrane layer

The benefits of economy of scale are evident in the production cost curve as
average production costs per part rapidly decreases with production volume until
approximately 1,000 cores per year are reached, after which only slight decreases in
COGS are observed. This effect can be attributed to increased tool and labor utilization
which act to distribute initial capital tooling investment and labor costs over a greater
number of manufactured parts [17], [18], [31], [32]. This is illustrated by the decrease
in tooling, maintenance and labor costs as a portion of COGS with increases in
production volume (Fig. 5b-d). Although maintenance cost per tool per year is set as
5% of tool capital cost (Table 5), Fig. 5b-d show that the tooling and maintenance cost
elements as a portion of COGS per ERV core are nearly equal. This is because tooling
capital costs are distributed across all the ERV cores manufactured throughout the
tool’s lifetime (20 years), while maintenance is counted as a yearly cost and hence only
distributed across the ERV cores manufactured within one year [31], [32]. At higher
production volumes, Fig. 5c and 5d show that material (membrane) and consumables
(adhesive) dominate ERV core costs, suggesting manufacturing costs can be reduced
even further with selection of a less expensive adhesive.
Our target production volume of 5,000 ERV cores per year lies well below the
cost target of 2,100 USD / ERV core and within the asymptotic region of this trend,
suggesting efficient tool utilization and economic viability of our MPD. Moreover, the
COGS remains relatively constant between 2,000 and 10,000 cores per year, suggesting
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that the proposed manufacturing process is robust to a wide variety of annual
production volumes even when process parameters are held constant.
To estimate the lower limit of economically viable annual production volume,
non-linear regression of the calculated data was performed using the MATLAB R2018a
Curve Fitting Toolbox 3.5.7, yielding the following relation between COGS and annual
production volume P at an R-squared value of 0.9971:
𝑈𝑆𝐷

𝐶𝑂𝐺𝑆 [𝐸𝑅𝑉 𝐶𝑜𝑟𝑒] = (6.014 ∗ 105 )𝑃−1.202 + 1845

(6)

Based on Eqn. 6, the MPD becomes economically viable for annual production
volumes of 642 ERV cores per year or more.
With a fully specified and economically verified MPD, our next step was to
design and run a series of experiments to determine whether the material requirements
in Table 4 and the MPD as a whole was validated.
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Chapter 3: Experimental Approach
Based on the previously established material requirements, a series of
experiments were designed to determine if those requirements could be met with the
current MPD. Additionally, experiments were designed for final MPD validation in
terms of the final process requirements. Although presented here in the context of
evaluating one specific adhesive (Dow Corning 3165 Fast Tack RTV Adhesive
Sealant), the same experimental approach can be used to qualify other non-slump
adhesives. Throughout all experiments, air temperature and relative humidity were
tracked as control variables, since both have a direct impact on the tack-free time and
curing rate of the selected adhesive. Air temperature and humidity were recorded at
the start and end of fabricating each test article and running each test using an Extech
RH390 Precision Psychrometer (± 1 °C and ± 2 %RH in the temperature and humidity
ranges of interest). For more information on the experimental dispensing tool, custom
vacuum grip fixtures for the bonding tool, and experimental curing tool used in tests
unless otherwise specified, see Appendices E, F, and G respectively.

3.1 Peel Strength
The objective of the peel strength test was to determine whether the average
peel bond strength of the adhesive could meet the cured bond strength requirement of
at least 1 mN/mm. Five peel test articles were fabricated under identical process
conditions. Test article design was motivated primarily by the need to simulate the
MPD chemistry and physics as closely as possible while still conforming to industry
standard peel test protocol. An ASTM F88/F88M-15 standard [33] was consulted
which is used in food and medical packaging industries to characterize the strength of
sealed films and pouches [34], [35], [36], [37], [38]. Based on this standard and the
maximum work envelope of the bonding unit, a final bond peel test article was designed
(Fig. 6) with long unbonded membrane tails for clamping in the roll direction of the
membrane and coated side of the membrane in contact with the adhesive bond. The
bond strength was anticipated to be weakest between the adhesive and the coated side
of the membrane due to the coating acting as a contaminate. Therefore, the test article
design yielded a conservative estimate for adhesive peel strength.
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Figure 6 - Final bond peel test article geometry
The peel test article was fabricated using a Nordson Asymtek DispenseMate D583 for adhesive dispense and Instron 5969 Dual Column Tabletop Testing System
with attached 30 kN Static Load Cell (Instron Cat. No. 2580-202), Rigid Coupling
(Instron Cat. No. 2501-346), and Compression Anvil, 50 mm (2 in) Diameter (Instron
Cat. No. 2501-083) in conjunction with custom vacuum grip fixtures for bonding. The
first step in this process was taping a 50.8 mm wide x 130 mm long membrane strip
onto the dispenser stage with the coated side facing up and machine roll direction
parallel to the tool x-axis, then depositing the adhesive pattern shown in Fig. 7. For
more information on the dispensing parameters used for the bond peel test article, see
Appendix H. In order to do so, the syringe nozzle tips were removed to enable
maximum flow rate. After dispensing, the adhesive was left open to air (open time) for
approximately 69 seconds based on a conservative interpretation of open time in the
MPD. To tack the adhesive with a second membrane, a 30 kN static load cell (Instron
2580-202) with modified platen (Instron 2501-346) was used as shown in Fig. 8. Note
that this load cell is different from the 50 N load cell for the bonding tool described in
Appendix F. The top platen was modified as a vacuum chuck built using stiff open pore
media attached to a vacuum intake. The overall parameters used for this bonding
process are shown in Table 6. After being bonded to yield the raw test article shape
shown in Fig. 9, each raw test article was cured in ambient conditions for 24 hours and
then cut to the geometry shown in Fig. 6 using a shear cutter.
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a)

b)

Figure 7 - Bond peel test article dispense pattern (a) and resulting adhesive beads
after dispense (b). All dimensions are in mm.

Figure 8 - Bonding tool setup for peel test article fabrication
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Table 6 - Bond peel test article bonding parameters
Platen start height
Platen compression height
Platen compression speed
Compression dwell time
Vacuum release time
Platen return speed
Platen end height

30 mm
1.249 mm
240 mm/min
15.93715 s
3s
600 mm/min
30 mm

Figure 9 - Raw bond peel test article after bonding process (to be cut to final target
dimensions)
In accordance with ASTM F88/F88M-15, peel tests were performed with
submersible side action grips (Instron 2752-005) paired with a 50 N static load cell
(Instron 2530-50N) as shown in Fig. 10. An initial tensile grip separation of 25 mm
and grip separation speed of 254 mm/min were used.

Average peel strength was

calculated by normalizing the measured load response of the plateau region by the
nominal test article bond width of 25.4 mm.
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a)

b)

Figure 10 - Experimental setup for running peel tests a) prior to sample loading, and
b) with loaded sample detail.

3.2 Dispensed Bead Profile
Dispense process capability was determined by measuring the mean bead height
across 3 six-bead arrays dispensed onto three separate 50 x 50 mm membrane squares
with their coated side facing upward, in accordance with the dispense parameters in
Table 7 and the dispense pattern that was used for bonded single layer test articles (Fig.
13a).
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Table 7 - Single layer bead profile test article dispensing parameters.
Parameter
Dispense pressure
Nozzle type
Pre-move delay factor
Down speed
Down accel
Dispense gap
Nozzle scan speed*
Shutoff distance
Suckback
Dwell
Backtrack gap
Backtrack length
Backtrack speed
Retract distance
Retract speed
Retract accel

Single Layer Bead
Profile Test Article
70 psi
16 ga tapered tip
0.2 s
50.8 mm/sec
7619.996 mm/s^2
1.6 mm
𝑣𝑠,𝑒𝑥𝑝𝑡
1.0 mm
N/A
0.5 s
5 mm
50 mm
700 mm/s
5 mm
500 mm/s
15000 mm/s^2

*Changes between tests according to Eqn. 7
Note that the experimental nozzle scan speed 𝑣𝑠,𝑒𝑥𝑝𝑡 was not a fixed value
between tests. Instead, to make the experimental dispensing process physics equivalent
to that of the specified manufacturing dispensing process, five mass flow rate trials
were taken at the 70 psi dispense pressure prior to the start of a test. Then, 𝑣𝑠,𝑒𝑥𝑝𝑡 was
set according to the average calculated speed of adhesive exiting the dispenser nozzle,
as shown in Eqn. 7.
4

𝑣𝑠,𝑒𝑥𝑝𝑡 = 𝜋𝐷2 ∗

̅ 𝑝𝑢𝑟𝑔𝑒
1000∗𝑚
𝑡𝑝𝑢𝑟𝑔𝑒 ∗𝜌𝑎𝑑ℎ

(7)

Where is the nominal nozzle inner diameter in millimeters and 𝜌𝑎𝑑ℎ is the uncured
adhesive density in grams per millimeter, assumed equivalent to the 1.35 g/mL cured
adhesive density provided by the vendor [30]. Likewise,

̅ 𝑝𝑢𝑟𝑔𝑒
𝑚
𝑡𝑝𝑢𝑟𝑔𝑒

represents the mean

mass flow rate over the five trials in g/sec.
After curing at 50 °C for three hours, the test articles were removed and
allowed to cool to room temperature. For each test article, bead height and maximum
bead width were measured at seven locations (Fig. 11c) using the cross-sectioning
technique described below. An analysis of variance (ANOVA) was carried out on each

28

measured parameter and compared to one another to determine whether each sample
profile was significantly different.
During initial testing, it was found that scanning white light interferometry
(SWLI) of our adhesive bead profiles was only capable of measuring bead height.
Hence a cross-sectioning technique was developed to enable the entire bead crosssection to be characterized via optical microscopy. To ensure repeatable perpendicular
cross-sectioning of each bead, two laser-cut blade guides were made to confine each
blade to vertical cuts in pre-defined locations, as shown in Fig. 11a and 11b. A Leica
Wild M3Z optical microscope (25x objective) with video overlay (AmScope MU300
camera) was calibrated and used to measure bead height. Fig. 12 shows the resulting
bead profile measurements from cross-sectioning and optical microscopy. Calibration
of this cross-sectioning technique was performed by comparing the bead height profile
obtained in the seven locations indicated in Fig. 11c with values from a SWLI
microscope (Zygo ZeScope; ZeMaps 1.16.78 software) obtained prior to crosssectioning. WLI measurements yielded an average bead height of 1034.26 ± 3.86 μm,
and optical microscopy measurements yielded an average bead height of 1033.33 ±
6.10 μm. This resulted in an average error of 0.92 µm from cross-sectioning and a
sample standard deviation of 4.48 µm (sample size = 7) for the bead height which is
well over one mm in dimension. Additionally, a t-test found no significant difference
between the mean bead heights characterized with either method.
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a)

b)

c)

Figure 11 - Cross-sectioning technique for dispensed bead profile measurements: a)
starting from initial test article loading onto a bottom knife guide, b) followed by
taping a top corresponding laser guide and cutting the sample through the knife guide,
and c) removal of the cross-sectioned test article.

Figure 12 - A bead height measurement based on the optical microscopy of a cross–
sectioned profile.

3.3 Fabrication of Single Layer and Multilayer Test Articles
For the remaining dimensional characterizations, single layer and multilayer
bead profile test articles were all designed to have the same xy footprint and dispense
pattern shown in Fig. 13. Cross-sections of these test articles are shown in Fig. 14. All
membrane layers were arranged with the membrane roll direction perpendicular to the
adhesive pattern for both test article types. In the single layer test article, each
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membrane layer’s coated side was in contact with the adhesive bonds. In the multilayer
test article, the membrane coating orientation was flipped with each layer to produce
alternating channels with coated membranes and uncoated membranes to simulate the
arrangement used in the ERV design. The six bead dispense pattern in both test articles
was designed to closely approximate the 16 second manufacturing dispensing process
time 𝑡𝑑𝑖𝑠𝑝 specified in the MPD when experimental dispensing nozzle scan speed is set
according to the average measured experimental dispense flow rate using Eqn. 7. To
enable fabrication of the single and multilayer test articles, an experimental setup was
developed as shown in Fig. 15. The three key process steps shown (dispensing,
bonding, and curing) were carried out using experimental tools designed to simulate
MPD machine tool capabilities.

a)

b)

Figure 13 - Top view of bead profile test article a) dispense pattern and measurement
cross-sectioning locations and b) resulting fabricated part. All dimensions are in mm.
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a)

b)

c)

d)

Figure 14 - Cross-sectional view of a) single-layer, b) double-layer, c) three-layer,
and d) five-layer bead profile test articles.

Figure 15 - Experimental machine tool arrangement for MPD validation tests
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Here, the three experimental tools were placed in close proximity to minimize
the move between process steps. To take advantage of the proximity of the dispensing
and bonding workstations, the curing tool was placed over the middle of the dispensing
tool work envelope forming a dispensing-curing workstation. This allowed both
processes to use the same CNC-controlled dispenser stage which automated the move
between the curing step and the next dispensing step. In addition to the three tools
designed to simulate the process steps in the MPD, a post-process curing station
(natural convective oven set at 50 °C) was added to allow fabricated test articles to be
fully cured prior to cross-sectioning and bead profile measurement.
Using this experimental setup, the procedure for the fabrication of a single
layer bead profile test article was to first calculate the scan speed based on the mass
flow rate through the nozzle. This was done to mitigate variations in mass flow rate
brought on by aging of the adhesive. Next a membrane square was placed at a
designated place on the dispensing stage and the adhesive pattern was dispensed
according the same parameters specified during the dispense process capability test
(Table 7), in order to achieve the same dispensing physics and bead profile as
characterized during the dispense process capability test. Afterwards, the test article
was manually moved from the dispensing-curing workstation to the bonding
workstation, where the test article was placed onto the bottom platen awaiting a new
membrane which was preloaded into the top vacuum chuck. After 54 seconds, the
bonding process commenced using the parameters shown in Table 8. Afterwards, the
bonding fixture released the test article and was moved back to the dispensing-curing
workstation. After 54 seconds, the curing tool (heat) was turned on and the dispensing
tool program moved the test article to the curing process. After 49 seconds, the stage
moved back to the original position for dispensing.
For multi-layer test articles, the dispensing and bonding controllers were set to
the next process height by loading in the program for the next layer, and the next
membrane was preloaded into the bonding unit while the test article was in the curing
process. If the layer number n was even, the membrane was loaded with the coated side
facing down, and if the layer number n was odd, the membrane was loaded with the
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coated side facing up. This produced the stacked alternating coated channel layer and
uncoated channel layer geometry also found in the ERV core design.
Heights in each layer n program were prepared according to the Eqns. 8 - 12,
with the relations between single layer and multilayer process parameters shown in Fig.
16 and 17. All other parameters during the dispensing and bonding process were held
constant.
[ℎ𝑛𝑜𝑧 ]𝑛 = 𝑛ℎ𝑚𝑒𝑚 + (𝑛 − 1)ℎ̅𝑏,𝐿1 + ℎ𝑛𝑜𝑧

(8)

[ℎ𝑠𝑡𝑎𝑟𝑡,𝑝 ]𝑛 = (𝑛 − 1)(ℎ𝑚𝑒𝑚 + ℎ̅𝑏,𝐿1 ) + ℎ𝑠𝑡𝑎𝑟𝑡,𝑝

(9)

[ℎ𝑐𝑜𝑚𝑝,𝑝 ]𝑛 = (𝑛 − 1)(ℎ𝑚𝑒𝑚 + ℎ̅𝑏,𝐿1 ) + ℎ𝑐𝑜𝑚𝑝,𝑝

(10)

[ℎ𝑑𝑟𝑎𝑤,𝑝 ]𝑛 = (𝑛 − 1)(ℎ𝑚𝑒𝑚 + ℎ̅𝑏,𝐿1 ) + ℎ𝑑𝑟𝑎𝑤,𝑝

(11)

[ℎ𝑒𝑛𝑑,𝑝 ]𝑛 = [ℎ𝑠𝑡𝑎𝑟𝑡,𝑝 ]𝑛+1 = 𝑛(ℎ𝑚𝑒𝑚 + ℎ̅𝑏,𝐿1 ) + ℎ𝑠𝑡𝑎𝑟𝑡,𝑝

(12)

Figure 16 - Diagram of multilayer dispense process nozzle – to – membrane gap (n =
3 for the parameter shown)
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Figure 17 - Multilayer bonding process parameters (n = 3 for the parameters shown)
The initial platen start, compression, and draw height values in these equations
can be taken from the single layer test article bonding parameters in Table 8, since the
first layer of the multilayer test article is identical to the single layer test article, and the
initial nozzle to membrane gap ℎ𝑛𝑜𝑧 is 1.6 mm, as specified for the dispense process
capability test and single layer test article fabrication procedure. The value for ℎ𝑚𝑒𝑚 ,
the nominal membrane thickness, can be taken from the ERV engineering
specifications (Table 1). Lastly, ℎ̅𝑏,𝐿1 represents the sample mean final single layer
bead height and is determined experimentally.
Ideally, these adjustments result in each adhesive layer experiencing the same
stretch upon lamination i.e. each bead is stretched from a starting height of 0.946 mm
to a final height of 1.500 mm (total bead stretch distance of 0.554 mm).
Afterwards, the cycle started over in the dispensing process step. After all
process steps were performed, the test article was loaded into the 50 °C drying oven
for three hours to achieve full cure of the fabricated test article. Once fully cured the
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test article could be cross-sectioned for bead profile measurement. A partial diagram
depicting the single layer and multilayer fabrication procedure is illustrated in Fig. 18.
*Set by calculation from the average dispense mass flow rate at the start of a test (Eqn.
7). For more details on programming the experimental machine tools to enable single
layer and multilayer test article fabrication, see Appendix I. For a more complete
description of the experimental single layer and multilayer test article fabrication
procedure, see Appendix J.

Table 8 - Single layer bead profile test article bonding parameters
Parameter

Variable

Initial platen start height
Initial platen compression height
Initial platen compression speed
Initial platen draw height
Initial platen draw speed
Draw dwell time
Vacuum release time
Platen return speed
Initial platen end height

ℎ𝑠𝑡𝑎𝑟𝑡,𝑝
ℎ𝑐𝑜𝑚𝑝,𝑝
𝑣𝑐𝑜𝑚𝑝,𝑝
ℎ𝑑𝑟𝑎𝑤,𝑝
𝑣𝑑𝑟𝑎𝑤,𝑝
𝑡𝑑𝑤𝑒𝑙𝑙
𝑡𝑟𝑒𝑙𝑒𝑎𝑠𝑒
𝑣𝑟𝑒𝑡𝑢𝑟𝑛
ℎ𝑒𝑛𝑑,𝑝

Single Layer Bead Profile
Test Article
30 mm
1 mm
240 mm/min
1.554 mm
15 mm/min
14 s
3s
600 mm/min
30 mm
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Figure 18 - Top view detail of combined experimental curing – dispense process
steps, depicted in order of operation as a.) dispensing process, b.) presentation of test
article to operator for unloading / move to the bonding tool after program pause, c.)
bonding process execution, d.) reloading of test article onto dispenser stage followed
by resumption of dispensing tool program, e.) Curing process execution, followed by
repetition of the dispense process in part a.

3.4 Stretched Bead Profiles
Single layer MPD validation tests had two objectives. First, the test would
determine whether the adhesive meets the tack-free material requirement such that the
in-process constraint 𝑡𝑡𝑓,𝑚𝑒𝑎𝑠𝑢𝑟𝑒𝑑 ≥ 𝑡𝑜𝑝𝑒𝑛,𝐿 is satisfied. Second, the test would
determine whether the adhesive meets the adhesive relaxation rate material requirement
such that the in-process constraint 𝑡𝑟𝑒𝑙𝑎𝑥 ≤ 𝑡𝑑𝑤𝑒𝑙𝑙 is satisfied. To accomplish this, three
test articles were fabricated according to the initially established single layer bead
profile test article process parameters (Table 7 and 8). Satisfaction of the degree of tack
material requirement and corresponding in-process constraint 𝑡𝑡𝑓,𝑚𝑒𝑎𝑠𝑢𝑟𝑒𝑑 ≥ 𝑡𝑜𝑝𝑒𝑛,𝐿
was easily determined by macroscopic observation of whether the adhesive completely
wetted to the top bonding membrane during the bonding process step. To determine
satisfaction of whether adhesive relaxation rate was sufficient (i.e. 𝑡𝑟𝑒𝑙𝑎𝑥 ≤ 𝑡𝑑𝑤𝑒𝑙𝑙 ),
bead height and maximum bead width were measured in each of five locations on each
test article as shown in Fig. 19a, yielding a sample size of 5 data points per measured
dimensional response.
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a)

b)

Figure 19 - Single layer test article a) measurement locations (red dots) and b)
example of measured dimensions.
Based on these data samples, the bead height:width aspect ratio was calculated
from the bead height and maximum bead width for each location. Then, for each test
article the adhesive was judged to have sufficiently relaxed (𝑡𝑟𝑒𝑙𝑎𝑥 ≤ 𝑡𝑑𝑤𝑒𝑙𝑙 ) if two
conditions were satisfied. The first condition is that the one-sided 95% confidence
interval lower limit on the population mean bead height lies above the target channel
height of 1.2 mm. The second condition is that the one-sided 95% confidence interval
lower limit lies above the target rib height:width aspect ratio of 1.25. These criteria
represent a conservative estimate for whether the bead has sufficiently stretched to
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indicate 𝑡𝑟𝑒𝑙𝑎𝑥 ≤ 𝑡𝑑𝑤𝑒𝑙𝑙 , as the confidence interval lower limit accounts for the
probability that the true population bead height and aspect ratio is smaller than
measured. Note that we do not require the exact target dimensions (i.e. process
parameters) to be achieved, as bonding parameters can be further optimized once
sufficient adhesive relaxation rate is demonstrated.
In addition, the results from all three test articles was used to calculate the
sample mean final single layer bead height ℎ̅𝑏,𝐿1 used for multilayer dispensing and
bonding parameter adjustment (Eqn. 8 - 12).

3.5 Curing Process Calibration
Experimental curing process capability was evaluated by measuring the
temperature profile during three separate curing process trials as a function of curing
time and location within a representative single layer bead profile test article. Here,
capability was determined according to whether the measured temperature profile was
spatially uniform for each trial (< 5 °C total variation across the test article), and
repeatable (< 5 °C total variation between trials). As all single and multilayer bead
profiles test articles are placed directly beneath the heat source during the curing
process, maximum spatial temperature variation in the adhesive layer was anticipated
between the middle and corner of the dispensed pattern.
To enable measurement of spatial temperature profiles within a single layer test
article, the bottom membrane was affixed with double sided sticky tape to the 1.1 mm
thick PC sheet used in the standard fabrication protocol. Then two Type K
thermocouples (Omega 5TC-GG-K-30-36: Type K thermocouple, 1 m (40”) long, 30
gauge, stripped lead termination) were taped to the membrane in the center and upper
left corner of the target test article dispense pattern, as shown in Fig. 20a and 20b.
Subsequent fabrication proceeded as normal, with the adhesive printing over and
embedding the thermocouple tips as shown in Fig. 20c. Note that to compensate for the
thickness of the PC sheet during the bonding process, the bonding tool platen separation
was tared with the PC sandwiched between the platens prior to test article fabrication.
After recording of the first heating curve during the curing process of the initial
test article fabrication, the test article was allowed to cool for 15 min. on the dispenser
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stage and subjected to the standard experimental curing process two more times,
yielding a total of three temperature profiles per thermocouple for process capability
evaluation. For all heating cycles, data collection was enabled using a standard
thermocouple reader (Sper Scientific 4-Channel Datalogging Thermometer 800024)
with associated software (TestLink SE309) and data cable (PC RS-232 – to – USB).

a)

b)

c)

Figure 20 - Single layer test article a) thermocouple placement locations, b)
thermocouple placement method, and c) final thermocouple embedding

3.6 Cured Bead Profiles
With multilayer dispensing and bonding parameter adjustments (Eqn. 8 - 12)
performed based on the experimentally measured sample mean final single layer bead
height ℎ̅𝑏,𝐿1 and the experimental curing process calibrated, a double layer MPD
validation test was developed. The primary objective of this test was to determine
whether the adhesive meets the Curing Rate material requirement; i.e. whether the inprocess material requirement of adhesive cure time being less than or equal to the layer
cure time (𝑡𝑐𝑢𝑟𝑒,𝑎𝑑ℎ ≤ 𝑡𝑐𝑢𝑟𝑒,𝐿 ) is satisfied. To accomplish this, three double layer test
articles were fabricated according to the multilayer test article fabrication protocol
using two layer assembly cycles and the same initial platen compression height as in
the single layer bead profile test. As with the single layer bead profile test, bead profile
measurements (height and maximum width) were taken at the 5 locations per test article
layer shown in Fig. 19a. This gives a data sample size of 10 responses per dimensional

40

parameter per test article. Using these data samples, a two-side statistical test was used
to estimate whether there was a statistically significant (p < 0.05) difference in
population mean bead height between layers within each test article. As mentioned in
the rationale for the layer cure time and adhesive cure time definitions, an insufficiently
cured adhesive bond after the curing process would result in significant build up of
cumulative strain in a multilayer stack, manifesting as a difference in mean channel
heights between layers. Hence this test was used to determine whether the adhesive met
the curing rate material requirement (𝑡𝑐𝑢𝑟𝑒,𝑎𝑑ℎ ≤ 𝑡𝑐𝑢𝑟𝑒,𝐿 ) in each test article.
After evaluation of the last in-process material constraint via double layer test,
final MPD validation tests were performed by fabricating one 3 layer and one 5 layer
test article and taking 5 bead profile measurements per layer as shown in Fig. 28a. The
objective of these tests were to confirm whether the MPD is capable of meeting all
dimensional process requirements, based on observed geometric behavior as more
layers are added to test articles. This was achieved by comparing the resulting total
sample mean bead height, bead height standard deviation, and bead height:width aspect
ratio to the dimensional process requirements. A secondary goal of these final
validation tests was to observe how mean bead profiles for each test article layer evolve
over the course of multiple bonding cycles.
With the completion of MPD validation tests, all in-process material constraints
and process requirements were experimentally evaluated, enabling a decision as to
whether the proposed MPD met all process requirements.
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Chapter 4: Results and Discussion
All statistical analyses in this section were performed in Minitab® 16.2.4,
unless otherwise noted. Also, all values following ± are the sample standard deviation.
During test article fabrication and testing, the average ambient air temperature was
found to range between 21.4 °C and 24.4 °C with a maximum standard deviation for
any one effort of 0.35 °C and an average relative humidity of 23.8 %RH and 52.1 %RH
with a maximum standard deviation of 2.88 %RH.

4.1 Peel Strength
Five peel test articles were fabricated using the procedure outlined in the
experimental approach. Peel testing on the five test articles (Fig. 22) yielded several
load-displacement curves (Fig. 21) which were evaluated for peel strength.

Figure 21 - Measured force versus clamp separation distance during peel testing
In all tests, distinctive initial peaks were observed followed by decay of the load
to a steady state equilibrium value with good consistency.

In trials 3 and 4,

anomalously high secondary peaks were observed which correlated with visual
observations of bulk elastic bending of the adhesive bond area at the onset of peeling,
artificially inflating the strain energy requirement. Bond failure was characterized by
adhesive peeling of the membrane from the top of the each bond area. The average
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peel load was found to be 0.57 N, well above the 0.1 N lower limit for the 50 N load
cell. Assuming a nominal bond width of 25.4 mm (Fig. 6), a 95% confidence interval
of the fully-cured peel strength was determined to be between 19.1 mN/mm and 26.0
mN/mm, even in the worst case scenario of adhesion between the two coated sides of
the membrane. For a more detailed discussion of possible sources for observed peel
strength variability, see Appendix K. This is well over an order of magnitude greater
than the process requirement of 1 mN/mm fully-cured peel strength.

Adhesive Peel
Failure Mode
(Membrane –
Adhesive Bond
Separation)

Fig. 22 - Example peel test, with adhesive peel failure mode shown.

4.2 Dispensed Bead Profile
Three test articles were fabricated to characterize the dispensed bead profile.
Due to the lack of a shut-off valve on the experimental dispensing tool, significant
nonuniformities, in the form of bulges and wisps, were observed at the start and end of
the lines, respectively (Fig. 23). An analysis of variance (ANOVA) was used to
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evaluate the bead profile dimensional variation between test articles. Residual plots
from this analysis show that all data measurements followed a normal distribution. No
statistically significant difference (p > 0.05) was found in the estimated population
mean bead height, maximum width, and aspect ratio (AR) having means of 1.06 ± 0.009
mm, 1.23 ± 0.01 mm, and 0.86 ± 0.01, respectively, showing good repeatability
between the bulge and wisp of each line. The increased variation for bead maximum
width versus bead height was ascribed to instabilities in the flow of the adhesive due to
air pockets or other viscous anomalies. The adhesive dispense containers were loaded
by hand and were susceptible to entrapped bubbles. These variations showed more
prominently in the bead maximum width because it had less physical constraint
compared with bead height, which was constrained above by the dispenser and below
by the substrate during dispensing.
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a)
Wisp

Bulge

b)

c)

d)

e)

Figure 23 - Typical dispensed bead test article a) macroscopic top view, b) close-up
top view of bulge, c) close-up top view of wisp, d) close-up side view of bulge, e)
close-up side view of wisp

4.3 Stretched Bead Profile
For each of the three single layer test articles that were stretched, a successful
tack across the entire layer pattern was observed, suggesting that the MPD bonding
conditions satisfied the first in-process material constraint (𝑡𝑡𝑓,𝑚𝑒𝑎𝑠𝑢𝑟𝑒𝑑 ≥ 𝑡𝑜𝑝𝑒𝑛,𝐿 ).
Further, the sample mean and standard deviation of the bead height was found to be
1.262 ± 0.03 mm. The lower limit of the 95% confidence interval for bead height was
1.25 mm which is above the target limit of 1.2 mm. Also, the sample mean and standard
deviation of the aspect ratio was found to be 1.35 ± 0.119. This provided a lower limit
of the 95% confidence interval for bead height:width aspect ratio of 1.29 which was
above the target limit for aspect ratio. Hence, the relaxation rate for the adhesive was
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found to be sufficient to meet process requirements, i.e. the second in-process material
constraint 𝑡𝑟𝑒𝑙𝑎𝑥 ≤ 𝑡𝑑𝑤𝑒𝑙𝑙 was satisfied.

4.4 Cured Bead Profile
The curing process was characterized yielding three temperature profiles as
shown in Fig. 24. Ambient air conditions across all tests were 21.4 ± 0.06 °C at 49.4 ±
0.3 %RH. The profiles were allowed to return to 24.9 ± 0.41 °C before the start of each
trial. In all cases, the total variation between the corner edge (T1) and center (T2) of
the adhesive pattern during the thermal cycle was less than 3 °C which is significantly
below the target specification of 5 °C. As shown in the middle and bottom profiles of
the figure, T2 was found to have a higher peak temperature which is likely due to the
air entering the flow vessel in the center where entry gases are at a higher temperature.
Hence we concluded that our experimental setup had sufficient spatial temperature
uniformity for all thermal cycles to enable uniform curing of the adhesive.
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Figure 24 - Spatial temperature profiles for three thermal cycles where thermocouple
1 (T1) was on the corner edge and thermocouple 2 (T2) was in the center of the test
article.
To investigate temperature profile repeatability, the curing process temperature
profiles for each thermocouple were plotted on the same graph as shown in Fig. 25.
Based on these plots it was found that temperature varied by a maximum of 7.2 °C
between the first and second trial for the centermost thermocouple. After the first trial,
the temperature variation was well below 5 °C between the second and third trial. In
particular, the total variation of the peak temperature reached by thermocouple 1
(corner edge) among all three trials was only 0.7 °C, and the total variation of the peak
temperature reached by thermocouple 2 (center) among all three trials was only 2.2 °C.
The largest discrepancy was between trial 1 and 2 for T1 which suggest thermal
accumulation in the setup over time. However, by the third cycle, it appears that there
was no additional thermal accumulation. All heating curves show gradual heating for
approximately 49 seconds, followed by asymptotic decay to ambient air temperature
due to natural convection. Hence we anticipated that the curing tool output would
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remain repeatable over the duration of testing with ≤ 5 °C spatial variation once the
tool warmed up.
Based on the temperature profiles in Fig. 26 it is clear that although there is a
high degree spatial temperature uniformity and repeatability between trials, the heating
ramp led to average peak temperatures of 43.7 °C and 44.6 °C for thermocouples 1 and
2, respectively, which is well below the maximum curing temperature of 60 °C as
recommended by the supplier. A more aggressive heating rate would likely lead to a
shorter curing time (𝑡𝑐𝑢𝑟𝑒,𝑎𝑑ℎ ).

Figure 25 – Temporal temperature profiles across three trials for top) thermocouple 1
(corner edge) and bottom) thermocouple 2 (center).
Bead profiles for three double layer test articles fabricated and measured
according to the procedure outlined in the experimental approach yielded a sample
mean bead height of 1.14 ± 0.04 mm for the top layer of all three test articles, and a
sample mean bead height of 1.31 ± 0.03 mm for the bottom layer of all three test
articles. For the bead height:width aspect ratio, the top layer had a sample mean of 1.10
± 0.0887, and the bottom layer had a sample mean of 1.38 ± 0.0579. Because the curing
rate of the selected adhesive is highly air temperature and humidity dependent,
interpretation of whether the in-process material constraint of 𝑡𝑐𝑢𝑟𝑒,𝑎𝑑ℎ ≤ 𝑡𝑐𝑢𝑟𝑒,𝐿 was
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satisfied during this test is considered specific to the ambient air conditions at the time
of test article fabrication.
As equality of variances, normality of residuals, and independence of residuals
were demonstrated between layers and trials, two-way ANOVA was used to compare
the means in bead heights between layers and test articles. Using this method, it was
found that the means for both bead height and bead height:width aspect ratio were
observed to differ significantly between test article layers (p < 0.05). If we take
differences in mean bead height and aspect ratio between layers as a sign of cumulative
plastic strain after multiple bonding cycles, then the result of a significant difference
between top and bottom mean layer bead height is an indication that the first layer was
not sufficiently cured prior to the start of the second layer bonding process. In other
words, the double layer test demonstrated that the curing rate material requirement and
related constraint of 𝑡𝑐𝑢𝑟𝑒,𝑎𝑑ℎ ≤ 𝑡𝑐𝑢𝑟𝑒,𝐿 was not satisfied.
Using the same standard multilayer fabrication and measurement procedure
outlined in the experimental approach, data sets were collected for one 3 layer and one
5 layer test article. Based on this data, it was found that in the 3 layer test article the
total mean bead height was 1.26 ± 0.06 mm, and the total mean bead height:width
aspect ratio was 1.36 ± 0.13. Likewise, for the 5 layer test article, the total mean bead
height was 1.25 ± 0.06 mm and the total mean bead height:width AR was 1.36 ± 0.12.
Applying the Kruskal-Wallis test to the data for the 3 layer test article, a
significant difference (p < 0.05) in mean bead profiles was found between layers. This
statistical comparison method was used because of the non-equality of variances
between layers and non-normality of data observation distribution in the 3 layer test
article. This manifested as significant tensile plastic deformation in the top layer (layer
1) and bottom layer (layer 3) compared to the middle layer. In contrast, ANOVA found
no significant difference in mean bead profile between layers (p > 0.05) for the 5 layer
test article. Here, ANOVA was used due to the equality of variances between layers
and normality of measurement distributions in the 5 layer test article.
To evaluate the evolution of bead height over the course of multiple bonding
cycles when 𝑡𝑐𝑢𝑟𝑒,𝑎𝑑ℎ > 𝑡𝑐𝑢𝑟𝑒,𝐿 (i.e. adhesive curing rate requirement not satisfied) the
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sample measured bead height mean and sample standard deviation for each layer of
each test article was plotted as a function of bonding cycles experienced (i.e. top layer
bead height measurements experienced 1 bonding cycle, 2nd layer from top
measurements experienced 2 bonding cycles, etc…).
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Figure 26 - Sample mean and standard deviation layer bead heights as a function of
test article type (vertical axis) and number of bonding cycles experiences (horizontal
axis)
Figure 26 shows the variation in channel height from two-layer to five-layer
test articles. For each test article, the thickness of the top adhesive layer is shown for
an x-axis value of one bonding cycle (top layer is leftmost). Similarly, the last bonding
cycle for each graph depicts the bottom layer and also the total number of layers for
each test article. As shown in Figure 26, the channel height in the three sets of test
articles vary between 1.31 to 1.20 mm. Of most important note, is the variation range
for the five-layer test article at 0.086 mm. Applying this range to a bilateral tolerance
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yields a +/- tolerance of 0.043 mm which is about 3.4%, well below the channel height
target of +/- 5%, which meets the overall dimensional requirement of the device.
Bead height variation can be attributed in part to differences in the strain energy
available to stretch each layer due to insufficiently cured layers in the existing stack.
For the two-layer test articles, the variation in bead height from the top layer to the
bottom layer is 0.17 mm which appeared to be significant. The rationale for this
variation is that when the second layer is formed in the two-layer test article, some of
the strain energy applied by stretching is consumed by the bottom layer which is likely
not cured. This can be seen by comparing the second-layer-from-the-bottom (SLFB)
for each of the devices. In the three-layer device, the SLFB is about 60 micrometers
taller than in the two-layer device, while in the five-layer device it is essentially the
same height as in the three-layer device. This means that the bead height of the SLFB
did not change substantially between the second and third bonding cycles suggesting
that the adhesive is cured after two cycles.
Finally, the open-loop nature of the bonding and stretching process may have
also contributed to differences in the available strain energy, leading to the oscillating
pattern of the bead heights within the three-layer and five-layer stacks. Based on the
protocol described in the experimental section, the absolute starting heights for the twolayer and three-layer test articles should have been the mean stack heights for the single
layer and two-layer test articles of 1.316 and 2.605 mm, respectively. Thus, by adding
another membrane and the intended stretch distance of 1.5 mm, the programmed
absolute platen draw heights for the two-layer and three-layer test articles would be
2.843 and 4.132 mm, respectively. Based on the data for single layer and two-layer test
articles above, the absolute starting heights for the two-layer and three-layer test articles
were 1.316 and 2.532 mm, respectively. Consequently, the stretch distance for the
second and third layers on average was 1.5 and 1.573 mm, respectively, suggesting that
the third layer on average received an additional 0.073 mm of strain compared with the
second layer.
Using data from the single layer test article, a retained stretch height of 0.316
mm was determined based on subtracting the retained single layer bead height (1.262
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mm) from the bead compression height (0.946 mm). This suggests that 57% of the
bead stretch distance (0.554 mm) is converted into retained bead height during
stretching of a single dispensed adhesive layer. In the case above, on average, the
additional stretch distance would increase the third layer by approximately 0.042 mm
over the second layer. This accounts for just over 50% of the increase in mean bead
height of the second and fourth layers compared with the third and fifth (top) layers of
the five-layer sample in Fig. 26. This assumes that all of the additional stretch distance
goes into the fifth layer which is contrary to evidence presented above. Based on the
consistency of the oscillating pattern seen in Fig. 26 between the three-layer and fivelayer test articles, it appears that the open-loop bonding process in this MPD
implementation is somewhat self-correcting.
To substantiate the observation that the cure state of previously bonded layers
affects observed mean bead height error, the bonding load response of a single layer
test article during fabrication was compared to the load response after full cure (3 hrs.
at 50 °C). It was found that adhesive stiffness is more than two orders of magnitude
greater after cure, resulting in no more than 0.004 mm of adhesive stretch during the
bonding process. This is well within the observed channel height variation of 0.043
mm, suggesting that the key source of uncertainty is insufficiently cured layers below
the top layer being stretched. It is expected that by curing the adhesive at higher
temperatures, channel height variation can be further improved.

4.5 Adhesive Wicking
Inspection of bond peel strength and double layer bead profile test articles after
several days of storage at ambient conditions after cure showed signs of significant
wicking of oily compounds into the membrane, as shown in Fig. 27. This wicking was
visible as translucent regions around adhesive bonds, and was the most prominent when
the adhesive bonds were in direct contact with the uncoated side of each membrane
layer. The variation in wicking behavior for different adhesive – membrane interfaces
can be ascribed to the higher density of open surface porosity on the uncoated side of
the membrane.
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a)

b)

c)

d)

e)

f)

Figure 27 - Images of various stages of adhesive wicking into membrane layers for a)
bond peel strength test article with uncoated sides of membrane in contact with
adhesive just after fabrication, b) bond peel strength test article with uncoated sides of
membrane in contact with adhesive several days after fabrication, c) bond peel
strength test article with coated sides of membrane in contact with adhesive just after
fabrication, d) bond peel strength test article with coated sides of membrane in
contact with adhesive several days after fabrication, e) double layer bead profile test
article with uncoated sides of membrane in contact with top adhesive layer just after
fabrication, and f) double layer bead profile test article with uncoated sides of
membrane in contact with top adhesive layer several days after fabrication
Literature review suggests that most one-part silicone RTV sealants contain low
molecular weight compounds which gradually diffuse to the surface of the cured rubber
to give the bond surface a degree of hydrophobicity [39], [40], [41], [42]. Because such
diffusion of compounds into the porous structure can potentially reduce membrane
mass transfer effectiveness, we have determined that another material requirement for
adhesive selection is that it should not wick into and clog the porous membrane
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structure. Hence it is likely that in future adhesive selection and applications of this
MPD, a different class of adhesive chemistry must be chosen such that no wicking into
the membrane occurs over extended periods of time.
For comparison purposes, the material requirement evaluation results of all
experiments are summarized in Table 9. Note that all tests were designed to adhere to
the required takt time, which was already demonstrated to meet the process cost
requirements. As can be seen from this table, only the adhesive curing rate (𝑡𝑐𝑢𝑟𝑒,𝑎𝑑ℎ ≤
208 sec) requirement was not satisfied.

Table 9 - Summarized material requirement evaluation results from experiments
Description
Adhesive Dispense
Temperature
Adhesive Cure Method

Presence of Solvent in
Adhesive
Adhesive Wetting Behavior

D*
Y

Category
B*
C*

Requirement
P*
Below 150 °C

Y

Non-UV energy source;
Global membrane temperature below 80 °C

Y

Adhesive should not be solvent – based

Y

Adhesive should wet the substrate membrane during
adhesive deposition
Adhesive bond strength and structure doesn’t
degrade under moisture

Adhesive Moisture
Resistance

Y

Adhesive Anti-Microbial
Resistance
Adhesive Tack-Free Time

Y
Y

Y

Adhesive Cured Bond
Strength
Adhesive Rheology

Y

Y

Adhesive Relaxation Rate

Adhesive Curing Rate

Y

Y

Y

Y

Y

Adhesive contains no nutrients for fungal / bacterial
growth
Adhesive is tacky enough to wet to membrane layers
during the manufacturing process (𝒕𝒕𝒇,𝒎𝒆𝒂𝒔𝒖𝒓𝒆𝒅 ≥
61sec)

Dow Corning 3165 Fast Tack RTV
Adhesive Sealant
Room Temperature
1 – part atmospheric moisture cure;
Cure can be accelerated with increased
humidity or heat < 60 °C
No solvent
Can wet to porous PP & sulfonated PEEK
Bond strength and structural strength
increases with moisture (moisture promotes
cure)
Non-nutritive to microbial growth
𝒕𝒕𝒇,𝒎𝒆𝒂𝒔𝒖𝒓𝒆𝒅 ≥ 61sec

Peel bond strength after full cure is high enough to
resist the largest anticipated pressure differential
during ERV operation
Adhesive does not yield / creep under its own weight
(non-slumping)
Adhesive internal draw stresses relax fast enough to
enable dimensional process requirements to be met,
provided bonding parameters are properly adjusted
(𝒕𝒓𝒆𝒍𝒂𝒙 ≤ 14 sec)

Two-sided 95% CI between 19.1 mN/mm
and 26.0 mN/mm

Adhesive is able to cure to a sufficiently stiff / elastic
state to lock in bond dimensions by the time of the
next applied load (𝒕𝒄𝒖𝒓𝒆,𝒂𝒅𝒉 ≤ 208 sec)

𝒕𝒄𝒖𝒓𝒆,𝒂𝒅𝒉 > 208 sec

Classified as “non-slump” adhesive
𝒕𝒓𝒆𝒍𝒂𝒙 ≤ 14 sec
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Chapter 5: Conclusions
Using a commercially available non-slump adhesive (Dow Corning 3165 Fast
Tack RTV Adhesive Sealant), this work demonstrates a novel surface mount adhesivebased manufacturing process capable of meeting the process requirements for a
membrane-based energy recovery ventilator (ERV). To this end, a set of process
requirements have been specified along with a set of adhesive requirements for guiding
adhesive selection for future applications of this method. Although the adhesive chosen
was found to be unacceptable due to wicking of a silicone oil into the membrane, it was
demonstrated that by judicious selection of a future adhesive, the final process
requirements may be met. Based on the final results, it was determined that improved
rib height control could be achieved through the use of higher thermal powers during
curing and a non-contact sensor to detect the stack height during bonding. For details
on other possible future work, see Appendix L.
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Appendix A: Cycle Time Analysis and Carousel Tool Details
The main assumptions for the initial cycle time analysis were as follows:
1. Any final inspection performed on manufactured ERV cores has negligible
impact on the overall cycle time, since it is only done on small samples of the
overall production volume.
2. Inclusion of the membrane conversion cycle times was unnecessary since
conversion of membrane to the desired elongated hexagonal geometry occurs
as an off-site parallel process to ERV core manufacture
3. All three layer assembly process steps (deposition, bonding, and curing) are
integrated into a single tool as workstations connected by a common rotating
carousel to enable three ERV cores to be processed at once, as shown in Fig.
A1:

Figure A1 – Top view of integrated carousel tool
The decision to integrate all three process steps into a single carousel tool was
based on several factors. As noted in past work, further optimization of the MPD can
be realized by grouping machine tools according to similar process step capability
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requirements [17]. This is especially true for our particular MPD, where a relatively
small number of process steps (i.e. less complications in tool integration) are repeated
many times per manufactured device. In particular, the dispensing, bonding, and curing
process steps all had similar capability requirements, including the need for rapid
movement times between each process step for layer assembly efficiency, and the need
to accommodate the large z – height (849.11 mm) of the final ERV core.
Both challenges were addressed by implementing a single rotating carousel
which acted as a common stage for shuttling ERV cores into position for each process
step. This carousel may be designed with z – height adjustment capability to increase
the effective maximum z – height accommodation for each machine tool, since it was
found that there are few existing machine tools with a large enough volumetric work
envelope. Alternatively, the ERV core may need to be split into smaller modular substacks which are removed on a periodic basis from the carousel. Each layer assembly
process step (dispensing, bonding, and curing) was conceptualized as individual
workstations along the carousel, resulting in the arrangement shown in Fig. A1.
Implementation of a single periodically rotating carousel was possible because no xy
positioning tolerance requirement was given for the ERV design specification, and
hence the carousel motion was deemed to have enough planar accuracy and precision
for our MPD.
Note that optimal process efficiency with such a carousel tool may be achieved
by feeding a roll of membrane pre-converted to the target laminae shape (Fig. 2a in the
main text) into the carousel tool duration operation. Then even further process
efficiency can be achieved by using a pick – and – place tool with two end effectors to
simultaneously perform the bonding & stretching process on an ERV core while
loading a new membrane for the next bonding & stretching process. The details of such
a tool and its related process parameters are described further in the bonding &
stretching process step analysis in the main text.
Based on the initial assumptions, we focused the cycle time analysis on the
carousel multilayer stacking sub-process.
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Since the three layer assembly process steps (dispensing, bonding, and curing)
are implemented as workstations connected to a common rigid carousel, incomplete
ERV stacks enter and exit each workstation simultaneously at regular intervals. Hence,
the time a given part spends in each process step workstation is connected by a common
takt time 𝑡𝑡𝑎𝑘𝑡 , equivalent to the time interval between carousel rotations.
To ensure that all carousel process steps are complete by the time of the next
carousel rotation, 𝑡𝑡𝑎𝑘𝑡 can be no shorter than the time taken to complete the longest
process step and move parts between workstations. Thus the minimum takt time is
constrained according to Eqn. A1
𝑡𝑡𝑎𝑘𝑡 ≥ max(𝑡𝑑𝑖𝑠𝑝 + 𝑡𝑚 , 𝑡𝑏𝑜𝑛𝑑 + 𝑡𝑚 , 𝑡𝑐𝑢𝑟𝑒 + 𝑡𝑚 )

(A1)

Here, 𝑡𝑚 is the move time, or time taken for the carousel to move a part between
workstations. The variables 𝑡𝑑𝑖𝑠𝑝 , 𝑡𝑏𝑜𝑛𝑑 , and 𝑡𝑐𝑢𝑟𝑒 represent the required dispense,
bonding, and curing process step times respectively. The exact breakdown of these
process step times are explained further in the process step analyses of the main text.
It is likely that not all required process step durations are equal, and even using
the shortest possible 𝑡𝑡𝑎𝑘𝑡 according to equation A1, at least one of the carousel
workstations will have an associated idle time 𝑡𝑖𝑑𝑙𝑒 between when a process step
finishes, and which the associated part is able to move to the to the next process step /
workstation for further assembly. Defining the idle times for each carousel workstation
according to their associated process step, we connect 𝑡𝑡𝑎𝑘𝑡 to the required process step
durations as:
𝑡𝑡𝑎𝑘𝑡 = 𝑡𝑑𝑖𝑠𝑝 + 𝑡𝑖𝑑𝑙𝑒,𝑑𝑖𝑠𝑝 + 𝑡𝑚

(A2)

𝑡𝑡𝑎𝑘𝑡 = 𝑡𝑏𝑜𝑛𝑑 + 𝑡𝑖𝑑𝑙𝑒,𝑏𝑜𝑛𝑑 + 𝑡𝑚
𝑡𝑡𝑎𝑘𝑡 = 𝑡𝑐𝑢𝑟𝑒 + 𝑡𝑖𝑑𝑙𝑒,𝑐𝑢𝑟𝑒 + 𝑡𝑚
where 𝑡𝑖𝑑𝑙𝑒,𝑑𝑖𝑠𝑝 , 𝑡𝑖𝑑𝑙𝑒,𝑏𝑜𝑛𝑑 , and 𝑡𝑖𝑑𝑙𝑒,𝑐𝑢𝑟𝑒 are the dispensing, bonding, and curing
process idle time. In an ideal manufacturing process, all carousel process step durations
are evenly matched so that idle times in each workstation are non-existent.
Based on the definitions of Eqn. A2 and carousel movement capability, the true
layer cycle time 𝑡𝐿 , or time that a given layer takes to complete one set of assembly
steps (dispensing, bonding and curing) can be notated according to Eqn. A3.
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𝑡𝐿 = (𝑡𝑑𝑖𝑠𝑝 + 𝑡𝑑𝑖𝑠𝑝,𝑖𝑑𝑙𝑒 + 𝑡𝑚 ) + (𝑡𝑏𝑜𝑛𝑑 + 𝑡𝑖𝑑𝑙𝑒,𝑏𝑜𝑛𝑑 + 𝑡𝑚 ) +
(𝑡𝑐𝑢𝑟𝑒 + 𝑡𝑖𝑑𝑙𝑒,𝑐𝑢𝑟𝑒 + 𝑡𝑚 ) = 3𝑡𝑡𝑎𝑘𝑡

(A3)

Note that 𝑡𝐿 is also equivalent to the time taken for one complete rotation of the
carousel.
Since 4 channel array layers / ERV cores are assembled simultaneously during
the carousel sub-process, we can determine the effective cycle time per layer by
normalizing 𝑡𝐿 according to the number of simultaneously manufactured layers. Hence:
𝑡𝐿,𝑒𝑓𝑓 =

𝑡𝐿

(A4)

3

Where 𝑡𝐿,𝑒𝑓𝑓 is the effective layer cycle time. This conversion is important because
cost modeling is based on the estimated overall rate of parts moving through the
manufacturing process (related to the tool capacity) relative to required production
rates, rather than the tracking of individual parts along the assembly line [17], [18],
[31], [32].
Inserting Eqn. A3 into Eqn. A4 gives a direct equivalence between 𝑡𝐿,𝑒𝑓𝑓 and
𝑡𝑡𝑎𝑘𝑡 :
𝑡𝐿,𝑒𝑓𝑓 =

(𝑡𝑑𝑖𝑠𝑝 +𝑡𝑑𝑖𝑠𝑝,𝑖𝑑𝑙𝑒 +𝑡𝑚 )+(𝑡𝑏𝑜𝑛𝑑 +𝑡𝑖𝑑𝑙𝑒,𝑏𝑜𝑛𝑑 +𝑡𝑚 )+(𝑡𝑐𝑢𝑟𝑒 +𝑡𝑖𝑑𝑙𝑒,𝑐𝑢𝑟𝑒 +𝑡𝑚 )
3

= 𝑡𝑡𝑎𝑘𝑡

(A5)

Multiplying Eqn. A5 by 𝑁𝐿 , or number of layers per ERV core, and taking into
consideration the 𝑡𝑡𝑎𝑘𝑡 constraint expressed in Eqn. A1, we obtain two expressions for
the effective ERV core manufacturing cycle time 𝑡𝑐 in terms of takt time and required
process step durations:
𝑡𝑐 = 𝑁𝐿 ∗ 𝑡𝐿,𝑒𝑓𝑓 = 𝑁𝐿 ∗ 𝑡𝑡𝑎𝑘𝑡

(A6)

𝑡𝑐 ≥ 𝑁𝐿 ∗ max(𝑡𝑑𝑖𝑠𝑝 + 𝑡𝑚 , 𝑡𝑏𝑜𝑛𝑑 + 𝑡𝑚 , 𝑡𝑐𝑢𝑟𝑒 + 𝑡𝑚 )

(A7)

Using previously established manufacturing process design and cost model
analysis methodologies [31], [32], [17], [18], the relation between cycle time and takt
time demonstrated in Eqn. A6 allows the required takt time 𝑡𝑡𝑎𝑘𝑡,𝑟𝑒𝑞 for a
manufacturing process to be determined based on the target production rate, the actual
production capacity per tool, and the target tool count 𝑛𝑡𝑜𝑜𝑙 . This calculation is shown
in Eqn. A7.

64

𝑛𝑡𝑜𝑜𝑙 = ⌈

𝑃
𝑘
1
𝑌∗( )∗𝑢
𝑡𝑐

𝑃
𝑘

⌉=⌈
𝑌∗(

1
𝑁𝐿 ∗𝑡𝑡𝑎𝑘𝑡,𝑟𝑒𝑞

⌉

(A7)

)∗𝑢

Where 𝑃 is the annual production volume, 𝑘 is the annual working hours per tool, 𝑌 is
the cumulative manufacturing process yield; i.e. the fraction of ERV cores which meet
all process requirements after complete manufacture, and 𝑢 is the tool utilization
fraction. Here, the symbol ⌈ ⌉ represents the ceiling step function.
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Appendix B: Layer Open Time and Layer Cure Time Definitions
The definition for layer open time can be understood by considering how the
selected adhesive’s surface behavior changes with ambient moisture exposure. Since
the adhesive forms a minimally tacky surface skin as it cures due to ambient
atmospheric exposure, longer exposure times are associated with reduced wetting of
the adhesive onto the top membrane during the bonding process. After a critical
exposure duration, the adhesive no longer wets onto the top membrane during the
bonding process and no bond is formed. However, adhesive layer pattern deposition is
not instantaneous during the manufacturing process, resulting in a range of minimallytacky surface skin thicknesses on the bead pattern due to varying lengths of ambient
atmospheric exposure time. Under certain cycle time conditions, this may result in only
part of the adhesive layer properly tacking to the top membrane during the bonding
process.
To avoid this manufacturing defect, a conservative criterion for determining
whether the entire layer will tack during the manufacturing process is whether
sufficient tack occurs even where the surface skin is thickest and least tacky. In this
manufacturing process, the region with thickest surface skin is expected to occur at the
very start of the dispense pattern, where exposure to ambient atmosphere is the longest
before bonding.
We can use the exposure time of this region (the start of the dispense pattern)
to determine whether the entire layer pattern will sufficient tack during the
manufacturing process. Thus, we define the layer open time, 𝑡𝑜𝑝𝑒𝑛,𝐿 as the maximum
amount of time that any portion in a layer’s adhesive dispense pattern is exposed to
ambient atmosphere; i.e. the amount of time between the start of adhesive deposition
in the dispense process and beginning of contact between the adhesive pattern and top
membrane during the subsequent bonding process. Mathematically, this parameter can
be approximated as:
𝑡𝑜𝑝𝑒𝑛,𝐿 ≈ 𝑡𝑡𝑎𝑘𝑡,𝑟𝑒𝑞 + 𝑡𝑏𝑏

(B1)

66

𝑡𝑜𝑝𝑒𝑛,𝐿 ≈ 𝑡𝑡𝑎𝑘𝑡,𝑟𝑒𝑞 +

ℎ𝑠𝑡𝑎𝑟𝑡,𝑝 −ℎ𝑐𝑜𝑚𝑝,𝑝

(B2)

𝑣𝑐𝑜𝑚𝑝

𝑡𝑜𝑝𝑒𝑛,𝐿 ≈ 𝑡𝑑𝑖𝑠𝑝 + 𝑡𝑖𝑑𝑙𝑒,𝑑𝑖𝑠𝑝 + 𝑡𝑚 + 𝑡𝑏𝑏
𝑊

𝑡𝑜𝑝𝑒𝑛,𝐿 ≈

𝑁

( √2+𝐿−𝑊)∗⌈ 𝑟𝑜𝑤𝑠 ⌉
2
𝑁𝑛𝑜𝑧
𝑣𝑠

+ 𝑡𝑖𝑑𝑙𝑒,𝑑𝑖𝑠𝑝 + 𝑡𝑚 +

(B3)
ℎ𝑠𝑡𝑎𝑟𝑡,𝑝 −ℎ𝑐𝑜𝑚𝑝,𝑝
𝑣𝑐𝑜𝑚𝑝

(B4)

Where the required takt time 𝑡𝑡𝑎𝑘𝑡,𝑟𝑒𝑞 is 54 sec as described in the main text, and all
other variables are defined according to Tables 1 and 3 in the main text. Note that ⌈ ⌉
represents the ceiling step function; i.e. the value within the brackets is rounded up to
the nearest integer.
In a similar manner to the layer open time, the definition for layer cure time can
be understood in consideration of how the selected adhesive’s bulk mechanical
behavior changes with ambient moisture exposure, and its effect on the deformation of
the entire multilayer ERV stack with each bonding cycle. In particular, with each
multilayer bond cycle some of the bonding load penetrates into the previously bonded
adhesive layers below, inducing deformation within them.
Ideally, the previously bonded layers only elastically deform due to the
transmitted load, resulting in no permanent dimensional change after each bonding
cycle. However, if these layers experience some degree of plastic deformation instead,
each layer may become increasingly compressed or stretched beyond the target channel
height with each bond cycle. This would increase the mean channel height error,
implying that each layer must have a minimum level of elasticity (maximum allowable
plasticity) by the start of the next layer’s bond cycle to remain within geometric
tolerance requirements by the end of ERV core assembly. Since the selected adhesive
becomes increasingly elastic as it cures, less cumulative plastic deformation occurs
when each adhesive layer is more cured by the start of the next layer’s bonding cycle.
This can be accomplished through three main methods:
1. Increasing the takt time such that the adhesive is exposed to ambient air for a
longer duration by the start of the next layer’s bonding cycle
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2. Increasing the time spent in the curing process step, since this process is
designed to accelerate adhesive curing rate beyond what it would normally be
in ambient conditions.
3. Increasing the temperature and / or humidity of the curing process step. As
mentioned during initial adhesive selection, consultation with the vendor and
the product’s data sheet [30] has shown that both temperature and humidity
significantly accelerate cure.
However, adhesive layer pattern deposition is not instantaneous during the
manufacturing process and some parts of the adhesive layer pattern will cure in ambient
atmosphere for longer durations, resulting in non-uniform bead elasticity across the
layer dispense pattern. This may cause the channel height error to vary across the
laminated channel stack footprint, such that geometric requirements are only met in
part of the stack. The layer region with smallest degree of cure during any given
bonding cycle is expected to occur at the end of the dispense pattern, where exposure
duration to ambient atmosphere is the shortest.
As a result, the exposure time of this region (the end of the dispense pattern)
can be used to determine whether the entire stack is cured enough to avoid excessive
cumulative plastic strain during the multilayer bonding process. Hence, we defined the
layer cure time, 𝑡𝑐𝑢𝑟𝑒,𝐿 as the amount of time between when the adhesive is first
dispensed and the start of the next layer’s bonding process. In terms of MPD cycle time
parameters, the layer cure time can be expressed as:
𝑡𝑐𝑢𝑟𝑒,𝐿 = (𝑡𝑖𝑑𝑙𝑒,𝑑𝑖𝑠𝑝 + 𝑡𝑚 ) + 𝑡𝑡𝑎𝑘𝑡,𝑟𝑒𝑞 + 𝑡𝑡𝑎𝑘𝑡,𝑟𝑒𝑞 + 𝑡𝑡𝑎𝑘𝑡,𝑟𝑒𝑞 + (𝑡𝑏𝑏 )
𝑡𝑐𝑢𝑟𝑒,𝐿 = (𝑡𝑡𝑎𝑘𝑡,𝑟𝑒𝑞 − 𝑡𝑑𝑖𝑠𝑝 ) + 3𝑡𝑡𝑎𝑘𝑡,𝑟𝑒𝑞 +
𝑊

𝑡𝑐𝑢𝑟𝑒,𝐿 =

𝑁

( √2+𝐿−𝑊)∗⌈ 𝑟𝑜𝑤𝑠 ⌉
𝑁𝑛𝑜𝑧
4𝑡𝑡𝑎𝑘𝑡,𝑟𝑒𝑞 − 2
𝑣𝑠

+

ℎ𝑠𝑡𝑎𝑟𝑡,𝑝 −ℎ𝑐𝑜𝑚𝑝,𝑝
𝑣𝑐𝑜𝑚𝑝,𝑝

ℎ𝑠𝑡𝑎𝑟𝑡,𝑝 −ℎ𝑐𝑜𝑚𝑝,𝑝
𝑣𝑐𝑜𝑚𝑝,𝑝

(B5)
(B6)

(B7)
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Where the required takt time 𝑡𝑡𝑎𝑘𝑡,𝑟𝑒𝑞 is 54 sec as described in the main text, and all
other variables are defined according to Tables 1 and 3 in the main text. Note that ⌈ ⌉
represents the ceiling step function; i.e. the value within the brackets is rounded up to
the nearest integer.
Fig. B1 shows these newly defined layer open time and layer cure time
parameters in relation to the MPD cycle time breakdown. For comparison with the
corresponding curing rate and tack-free time adhesive material requirements, the
measured adhesive tack – free time 𝑡𝑡𝑓,𝑚𝑒𝑎𝑠𝑢𝑟𝑒𝑑 and the adhesive cure time 𝑡𝑐𝑢𝑟𝑒,𝑎𝑑ℎ
as defined in the main text are also shown in this figure. In this case, the cycle time
breakdown

shown

in

Fig.

B1

satisfies

the

two

in-process

material

requirements 𝑡𝑡𝑓,𝑚𝑒𝑎𝑠𝑢𝑟𝑒𝑑 ≥ 𝑡𝑜𝑝𝑒𝑛,𝐿 and 𝑡𝑐𝑢𝑟𝑒,𝑎𝑑ℎ ≤ 𝑡𝑐𝑢𝑟𝑒,𝐿 (Eqn. 2 and 5 in the main
text.)

Figure B1 - MPD cycle time analysis with measured adhesive tack-free time and
adhesive cure time in relation to layer open time and layer cure time. Process sub-step
variables are defined according to the main text.
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Appendix C: Bonding Process Breakdown
A detailed breakdown of the bonding process is as follows:
1. While gripping a pre-cut membrane with vacuum load, the bonding platen is
lowered from the initial platen start height ℎ𝑠𝑡𝑎𝑟𝑡,𝑝 to the initial platen
compression height ℎ𝑐𝑜𝑚𝑝,𝑝 at the platen compression speed 𝑣𝑐𝑜𝑚𝑝,𝑝 . This
process sub-step is designed so that the membrane adequately tacks to the
dispensed adhesive layer for initial bond formation. The duration of this
compression sub-step is designated as the pre-bond time 𝑡𝑏𝑏 , and is equal to
ℎ𝑠𝑡𝑎𝑟𝑡,𝑝 −ℎ𝑐𝑜𝑚𝑝,𝑝
𝑣𝑐𝑜𝑚𝑝,𝑝

.

2. While gripping the pre-cut membrane with vacuum load, the bonding platen is
raised at the platen draw speed 𝑣𝑑𝑟𝑎𝑤,𝑝 until it reaches the initial platen draw
height ℎ𝑑𝑟𝑎𝑤,𝑝 . This process sub-step stretches the newly formed adhesive bond
to increase its height:width aspect ratio. To account for any possible elastic
rebound of the adhesive bead to its unbonded state, the bead is stretched beyond
the target channel height in this sub-step. Additionally, the vacuum load must
be greater than the maximum tensile load exerted by the stretched adhesive
bonds on the platens to ensure that the top membrane doesn’t separate from the
bonding platen. The duration of this draw sub-step is designated as the draw
time 𝑡𝑑𝑟𝑎𝑤 , and is equal to

ℎ𝑑𝑟𝑎𝑤,𝑝 −ℎ𝑐𝑜𝑚𝑝,𝑝
𝑣𝑑𝑟𝑎𝑤,𝑝

.

3. While gripping the pre-cut membrane with vacuum load, the bonding platen is
held at the initial platen draw height ℎ𝑑𝑟𝑎𝑤,𝑝 for the draw dwell time 𝑡𝑑𝑤𝑒𝑙𝑙 .
This process sub-step ensures that any residual stresses within the stretched
adhesive bond dissipate prior to the end of the bonding process step. Without
this sub-step, residual stresses may exacerbate elastic rebound of the bead to the
undeformed state, increasing adhesive rib dimensional error and variability.
4. The vacuum hold down force is released, and the bonding platen is held at the
initial platen draw height ℎ𝑑𝑟𝑎𝑤,𝑝 for a fixed vacuum release time 𝑡𝑟𝑒𝑙𝑒𝑎𝑠𝑒 to
ensure that any residual vacuum load dissipates before the platen moves again.
Without this sub-step, slight residual vacuum load could causes the platens to
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exert undesired force on the adhesive bond after the dimension – defining draw
and draw dwell sub-step, resulting in the bond being ripped apart or damaged
as the platen rapidly moves to the bonding process end position.
5. The bonding platen is rapidly moved away from the bonded layer to the initial
platen end height ℎ𝑒𝑛𝑑,𝑝 at the platen return speed 𝑣𝑟𝑒𝑡𝑢𝑟𝑛,𝑝 . This position
becomes the platen start height for the next bonding cycle starting at step 1. The
duration of this return sub-step is designated as the post-bond time 𝑡𝑎𝑏 , and is
equal to

ℎ𝑒𝑛𝑑,𝑝 −ℎ𝑑𝑟𝑎𝑤,𝑝
𝑣𝑟𝑒𝑡𝑢𝑟𝑛,𝑝

.

The progression of platen separation versus time from this sequence of sub-steps is
shown in Fig. C1.

Figure C1 - Bonding process platen separation versus time. Solid green lines
represent the part of the bonding process when the vacuum load is active, and dashed
green lines represent the part of the bonding process when the vacuum load is
inactive.
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Appendix D: Cost Model Assumptions
To enable development of a cost model, the process flow diagram shown in Fig.
3 of the main text was fleshed out into a detailed machine tool flow diagram based on
subsequent process step analysis and machine tool specification. This detailed diagram
is shown in Fig. D1.

Figure D1 - Machine Tool Flow Diagram. Blue cells represent discrete process steps,
and green cells represent tool material inputs.
In particular, note that in addition to the specified layer lamination machine
tools being integrated into a single carousel tool, an additional offsite membrane
conversion sub-process was added to the overall process flow. This group of process
steps (lamination, slitting, kiss-cutting, and de-webbing) was necessary to convert the
raw rectangular roll to a series of pre-cut membranes for rapid implementation in the
final laminated channel array assembly. It was found that this is most efficiently
implemented at a dedicated off-site web conversion vendor because such a vendor has
the knowledge and much of the existing tooling to implement the required membrane
conversion effectively. While this would normally entail a new set of machine tool
specifications, we determined this as unnecessary since the web conversion vendor was

72

able to provide a membrane conversion cost which already accounts for full machine
tool specification and production capacity considerations.
Beyond the detailed process flow shown in Fig. D1, in our cost model several
simplifying assumptions about the overall process flow were made.
First, because the membrane conversion costs provided by the offsite vendor
already accounted for the machine tooling, labor, etc… considerations which factor
into production cost modeling [31], [32], [17], [18], we were able to account for the
membrane conversion sub-process in overall ERV production costs by treating overall
ERV membrane price as the sum of raw membrane costs (5 USD per square meter),
and membrane conversion costs (quoted by the web conversion vendor as 0.348 USD
/ converted membrane layer). To account for the mismatch between target post conversion membrane layer shape, and raw membrane roll dimensions (991 mm width)
from the film manufacturer, we assumed that each converted membrane layer would
require a raw membrane area of 720 mm x 13 inches based on our web conversion
vendor’s tooling capability and the slitting of the raw roll into three narrower rolls. This
is shown in Fig. D2.

Figure D2 – Membrane roll dimensions before and after conversion
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We also treated production costs from the final inspection process step as
negligible, since inspection will be relatively infrequent in a well – designed MPD
which meets all process requirements. Since preliminary cycle time analysis showed
that all process steps on the carousel assembly adhere to a common takt time, we further
treated the carousel sub-process with dispensing, bonding, and curing process steps as
a single tool and process step in the cost model, with an assumed move time of 5
seconds between each process step workstation. This results in the production cost
model reducing to the analysis of cost elements for a single carousel tool.
Globally, we assumed that the overall yield of the carousel tool is 95% after full
assembly of each ERV core, and the target yearly production volume is 5,000 ERV
cores. Each carousel tool additionally operates for 24 hours per day at 343 days per
year, with a maximum utilization of 95% before additional tool purchase and
installation is required. Capital cost for each tool (1,770,000 USD) was calculated by
assuming total cost is three times the maximum estimated cost from the vendor for the
selected dispense machine tool, since the vendor estimate included workpiece locating
robot costs which extrapolate to rotating carousel component costs. Because the
dispense tooling is anticipated to be more expensive than both the bonding and curing
tools, this assumption may contribute to an overestimate of final production cost.
Similarly, the installation cost for each carousel tool (18,000 USD) was estimated as
four times the quoted installation cost for a single dispense unit to account for the
rotating carousel component and all three process step workstations. Tool lifetime was
assumed as 20 years.
Based on an assumption that each carousel tool has a footprint equal to four
times the quoted dispense tool footprint and working space equal to the estimated
footprint, the total space required for each tool was estimated as 36 square meters, with
manufacturing facility floor space having a cost of 1,000 USD per square meter and
overall building lifetime of 25 years. Labor parameters were assumed at 1 operator per
carousel tool with an annual salary of 50,000 USD per year at a loaded cost rate of 1.5
to account for additional labor expenses. Yearly maintenance costs were assumed
equivalent to 5% of estimated carousel tool capital costs. Finally, total tool utilities
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power draw was assumed as 195 kWh/hr, or three times the estimated energy usage of
one dispensing machine tool, with a pricing of 0.06723 USD per kWh based on average
electrical rates for industrial customers in Portland, OR in 2015 [43]. In this case, the
original machine tool specification of 65 kWh/hr included the position robot power
draw, so no extra electrical draw was assumed for the rotating carousel in addition to
the three process step workstation tools.
Within each carousel tool, the dispense workstation was assumed to have 5
nozzles and a scan speed of 250 mm/sec per nozzle based on the initial tool
specification. Adhesive and nozzle tips were treated as consumables for this
workstation, with adhesive priced at 0.035 USD / mL and nozzle tips priced at 10
USD/nozzle based on vendor quotes. Additionally, each nozzle was assumed to last for
24 hours before replacement, while the adhesive consumption rate was estimated based
on the cycle time and assumptions regarding the final adhesive rib geometry. If we
assume that the deposited beads confirm to the ideal channel rib geometry with
rectangular cross-sections in the ERV design, then the total volume of adhesive used
in all dispense process steps to build one ERV core, 𝑉𝑎𝑑ℎ , is given by Eqn. D1:
2
ℎ𝑡𝑎𝑟𝑔𝑒𝑡

𝑤

𝑉𝑎𝑑ℎ = ( 2 √2 + 𝐿 − 𝑊) ∗ 𝐴𝑅

𝑡𝑎𝑟𝑔𝑒𝑡

∗ 𝑁𝑟𝑜𝑤𝑠 ∗ 𝑁𝐿

(D1)

Here, ℎ𝑡𝑎𝑟𝑔𝑒𝑡 is the ideal rib (channel) height, 𝐴𝑅𝑡𝑎𝑟𝑔𝑒𝑡 is the ideal rib height:width
aspect ratio, and 𝑁𝐿 is the total number of layers in the ERV core.
Dividing this volume by the effective ERV core manufacturing cycle time 𝑡𝑐
(shown to be proportional to 𝑡𝑡𝑎𝑘𝑡,𝑟𝑒𝑞 in Appendix A) yields the adhesive consumption
rate 𝑟𝑎𝑑ℎ , as shown in Eqn. D2:
𝑤

𝑟𝑎𝑑ℎ =

ℎ2
𝑡𝑎𝑟𝑔𝑒𝑡

( √2+𝐿−𝑊)∗
2
𝐴𝑅

𝑡𝑎𝑟𝑔𝑒𝑡

𝑡𝑐

∗𝑁𝑟𝑜𝑤𝑠 ∗𝑁𝐿

𝑤

=

ℎ2
𝑡𝑎𝑟𝑔𝑒𝑡

( √2+𝐿−𝑊)∗
2
𝐴𝑅

𝑡𝑎𝑟𝑔𝑒𝑡

∗𝑁𝑟𝑜𝑤𝑠 ∗𝑁𝐿

𝑁𝐿 ∗𝑡𝑡𝑎𝑘𝑡,𝑟𝑒𝑞

(D2)

For the dispense workstation, an estimated dispense bonding process time of 16
seconds was calculated based on the dispensing parameters as outlined in the main text.
Likewise, for the bonding workstation, an estimated bonding process time of 29
seconds was calculated from a set of anticipated ideal bonding process step parameters
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as outlined in the main text. Finally, for the curing workstation, an assumed required
curing process time of 49 seconds was used as outlined in the main text.
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Appendix E: Experimental Dispensing Machine Tool Specification
For an experimental equivalent to the selected machine tool, we chose a timepressure dispense system with an integrated robot gantry system (Nordson Asymtek
DispenseMate D-583), as shown in Fig. E1.

a)

b)

Figure E1 - Experimental dispensing machine tool with controller laptop a) front view
and b) stage detail
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All robot motion was programmed using a closed-loop controller software
(Fluidmove for Windows XP (FmXP)). This system was capable of ± 75 μm xy
positional accuracy, ± 100 μm xy placement accuracy, and ± 25 μm z – axis
repeatability, with a work envelope of 265 mm x 275 mm [44]. The smaller work
envelope of this tool compared to the manufacturing tool was not a major concern as
experimental test articles were designed to be significantly smaller than the ERV
design, as outlined in the experimental approach of the main text. To avoid possible
repeatability error due to variability in test article – machine tool interaction, all test
articles were fabricated in the same location on the dispenser stage, as shown in Fig.
E1b. The 1.1 mm thick PC square was used as a substrate beneath the test article, since
it was found that the static electricity from this material provided sufficient clamping
force during the experimental dispensing process without the need of tape or glue that
could damage the test article or lead to handling difficulties.
To ensure repeatable placement of the experimental test article adhesive layer
dispense pattern, the system was capable of xy position calibration according to part
fiducials with each new dispensing cycle. Unlike the proposed full scale manufacturing
dispense tool, the experimental dispense tool lacked a shut-off valve at near the
dispense nozzle exit. Instead, a set of bead parameters were provided in the controller
software to control the start, stop, and controlled move dispense behavior. These
parameters are as follows [45]:
1. Pre-Move Delay Factor
2. Down Speed
3. Down Acceleration
4. Dispense Gap
5. Speed
6. Shutoff Distance
7. Suckback
8. Dwell
9. Backtrack Gap
10. Backtrack Length
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11. Backtrack Speed
12. Retract Distance
13. Retract Speed
14. Retract Acceleration
Of these software parameters, only the dispense gap and (nozzle scan) speed were
anticipated to have significant effect on the dispense behavior and have direct
analogues to the manufacturing dispensing process step. Hence most of these
parameters will not be detailed further. Two additional non-software parameters which
were expected to impact experimental dispense behavior are dispense fluid pressure (0
– 60 psi), and nozzle diameter. As shown in Fig. E1a, dispense fluid pressure is set
manually prior to test article fabrication with an analog knob.
There are several factors which may possibly cause a discrepancy between the
manufacturing dispense process and experimental dispense process:
1. The flow rate of this system was likely to be less consistent than in the
displacement – driven deposition of the proposed manufacturing dispense tool.
For example, it is well documented that even with fixed parameters, a timepressure dispense system’s flow rate may significantly drop as the syringe
empties [28], [46], or otherwise change over time due to the complex timedependent Non-Newtonian behavior of many adhesives [29], [47]. This is
especially the case if there is significant batch – to – batch compositional
variation between the adhesive sources used for each experimental dispense
cycle.
2. The maximum flow rate of the experimental dispense tool was much less than
the displacement – driven manufacturing dispense tool.
3. There was no nozzle shut-off valve in the experimental dispense tool, likely
leading to the formation of bead start / stop defects (bulging and wisps) which
are minimized in the proposed manufacturing dispense tool.
4. Closed – loop automated adjustment of the nozzle – to – membrane gap for each
new layer in the experimental test article was not possible. This is because the
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built in z-height probe would significantly deform the test article structure
during contact, leading to calibration inaccuracy and test article damage.
However, it was possible to overcome these factors and adjust the experimental
time-pressure dispense tool so that it adequately simulates the chemistry and physics
of the manufacturing process. The adjustments used are as follows:
1. To overcome the difference between the experimental and manufacturing
dispense tool flow rates, the experimental dispense tool nozzle scan speed was
adjusted so that it matches the average measured adhesive nozzle exit speed
prior to running a series of closely spaced experimental dispense cycles.
Assuming adhesive nozzle exit flow rate is constant, this was determined
experimentally by running five dispense purge trials and measuring the
resulting purge mass 𝑚𝑝𝑢𝑟𝑔𝑒 in grams for a given purge duration 𝑡𝑝𝑢𝑟𝑔𝑒 in
seconds. Then the experimental nozzle scan speed 𝑣𝑠,𝑒𝑥𝑝𝑡 could be set equal to
the average adhesive nozzle exit speed through Eqn. 7 in the main text.
If the manufacturing dispense tool is also programmed to match the
rotor speed (and hence flow rate) to the target bead deposition rate of 250
mm/min per nozzle, then the discrepancies between mechanical strain on the
adhesive in the experimental and manufacturing dispense process steps can be
minimized. It is assumed that the other anticipated key variables which
influence dispense physics (particularly nozzle diameter and nozzle – to –
membrane gap) can be matched between the two machine tools.
2. To compensate for the mismatched dispense duration between the experimental
and manufacturing dispense process steps due to matching scan speed with
adhesive nozzle exit speed, the experimental test article dispense pattern was
modified until the total dispense duration matches the ERV layer adhesive
pattern dispense duration, as detailed further in discussion of experimental
approach. This ensured that the chemistry (i.e. gradient in degree of cure) of the
two resulting dispensed adhesive patterns are identical
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3. To avoid measuring erroneous start / stop bead geometry that only occurs in the
experimental dispensing process step, dimensional measurements were only
taken in the middle section of each adhesive bead.
4. To overcome the lack of closed-loop nozzle-to-membrane gap adjustment
between test article layers, the required nozzle – to – membrane gap adjustment
for each layer was estimated based on the measured bead heights from a single
layer bonding process and membrane thickness, as discussed in the
experimental approach outlined in the main text using Eqn. 8.
Note that this method required measurement of the mean final bead
height of single – layer test articles in order for the proper nozzle – to –
membrane dispense gap for subsequent multilayer dispense processes to be
calculated. Additionally any inaccuracy or imprecision in this measured bead
height may lead to a systematic error between required and actual nozzle – to –
membrane gap after enough experimental test article layers.
By implementing the experimental time-dispense tool with these adjustments,
we ensured that our experimental dispense process was able to validate the dispense
process step in the MPD by simulating the chemistry and physics of the true
manufacturing dispense process step as closely as possible.
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Appendix F: Experimental Bonding Machine Tool Specification
For the experimental bonding process an integrated tool was assembled
consisting of a set of custom fabricated vacuum grip fixtures attached to a standard
universal testing machine (Instron 5969 Dual Column Tabletop Testing System) fitted
with a 50 N load cell (Instron Cat. No. 2530-50N: 50 N Static Load Cell) and stainless
steel platens (Instron Cat. No. 2501-083: Compression Anvil, 50 mm (2 in) Diameter),
as shown in Fig. F1. This tool was designed to simulate the specified manufacturing
precision vacuum chuck pick-and-place tool. In particular, the universal testing
machine has open –loop programmable motion via Bluehill 3.12.1238 software, and
has a displacement accuracy equal to the greater of ± 0.01 mm or 0.05% of the currently
measured displacement when operated without load [48]. Hence the integrated tool’s
positioning ability is accurate enough to emulate the motion control required for the
manufacturing bonding process. One limitation of this tool compared to the ideal
manufacturing machine tool specification is that there is no non-contact sensor to
enable automatic adjustment of the bonding parameters with each layer based on the
position of the top surface of the test article. In other words the experimental bonding
process is open-loop, in contrast with the ideal manufacturing closed-loop bonding
process. As outlined in the experimental approach of the main text, the nominal
membrane thickness and measured bead heights from a single layer bonding process
were used to estimate the appropriate multilayer bonding parameter adjustment
according to Eqn. 9 - 12.
Since the work envelope (i.e. platen dimensions) of this tool was limited to a 2”
x 2” area, all experimental test articles were designed to have a bonded area footprint
of no more than 2” x 2”, as described in the experimental approach of the main text.
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Figure F1 - Integrated experimental bonding machine tool
To enable attachment of the vacuum grip fixtures to the machine, each fixture
was designed to have brackets which can be screwed onto the threaded holes of
standard stainless steel compression platens (Instron Cat. No. 2501-083: Compression
Anvil, 50 mm (2 in) Diameter). Then, the top vacuum grip fixture and steel
compression platen assembly are directly attached to the load cell, as shown in Fig.
F2a. Meanwhile, the bottom vacuum grip fixture and steel compression platen
assembly are attached to the universal testing machine’s base with a standard connector
(Instron Cat. No. 2501-346: Rigid Coupling 2501-346), as shown in Fig. F2b.
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a)

b)

Figure F2 - Close up of a) top vacuum grip fixture and b) bottom vacuum grip fixture
attached to universal testing machine
On each of the vacuum grip fixtures, stiff platen end – effectors capable of
evenly transmitting vacuum load were fabricated as follows. First, plenum base plates
were fabricated by milling a network of ¼” wide x 1/16” deep vacuum flow channels
into one 4”x 4” x ¼” and one 2-1/4” x 2-1/4” x ¼” aluminum plate in order to distribute
vacuum flow to all edges of the entire intended platen area, as seen in Fig. F3. Then, to
enable connection to an external vacuum feed, a small hole was drilled through the side
of each plenum, followed by the attachment of a barbed fitting to the drilled side hold
in each plenum plate for easy attachment and removal of vacuum intake lines.
Additionally, to enable individual manual control over the vacuum load gripping and
release for each platen, each vacuum intake line was fitted with a manual one-way
valve, as shown in Fig. F1.
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a)

b)

Figure F3 – Images of a) top plenum base plate and b) bottom plenum base plate
Then, two 2” x 2” platens were fabricated from ¾” thick Trupan Ultralight
MDF, a type of highly porous fiber board often used in CNC bleeder board vacuum
holding applications where an evenly distributed vacuum hold down force over a large
area is required. Because the outer surface of this material is partially sealed with resin,
0.05” was milled from both faces of the MDF to fully expose the open pore structure
before further platen assembly fabrication. Then, each platen was glued to the plenum
base plates shown in Fig. F3 and the adhesive was allowed to fully cure.
As variation in platen gap during the bonding process leads to a direct increase
in bonded adhesive bead / channel height error in the experimental test article, it was
necessary to minimize parallelism between the newly fabricated platens of the two
fixtures. While it is the final platen parallelism which relates to the total platen gap
variation, in practice the minimum achievable parallelism error between the two platens
is affected by the flatness of each surface. Hence it was important to make sure that
both platen surfaces were sufficiently flat before attempting to address potential
parallelism error. To achieve this, each surface was manually sanded down with
increasingly fine sandpaper down to a grit size of P1200.
To ensure repeatable minimum parallelism error with each re-attachment of the
vacuum grip fixtures to the universal testing machine, the vacuum grip fixtures were
designed so that the parallelism between the two platen end-effectors could be
manually adjusted after installing the fixtures. In practice, this meant that the bottom
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fixture required the capability for its platen to be manually rotated and then “locked”
in place once the proper alignment relative to the upper platen was found.
Hence, completion of the bottom vacuum grip fixture from the previously
fabricated bottom platen – plenum base plate assembly was achieved as follows. First,
a separate bracket plate was fabricated for attachment to one of the universal testing
machine’s stainless steel platens. Then the bracket plate was joined with the bottom
platen – plenum base plate assembly using a standard universal joint. This allowed the
bottom platen two degrees of rotational freedom for parallelism adjustment. In addition,
to allow a particular bottom platen alignment to be fixed in place, three fine adjustment
thumb screws were later added to the bottom bracket plate in a triangular arrangement.
When adjusted so that the tips of the adjustment screws are in contact with the bottom
platen – plenum assembly, the universal joint’s two degrees of rotational freedom are
hence eliminated, fixing the bottom platen’s alignment in place. The complete resulting
bottom vacuum grip assembly is shown in Fig. F4d-f.
Completion of the top vacuum grip fixture from the top platen – plenum base
plate assembly was much more straight forward, since the item was designed be fixed
relative to the universal testing machine crosshead motion. In this case, a set of brackets
were merely attached to the platen – plenum base plate assembly.
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a)

b)

c)

d)

e)

f)

Figure F4 – Images of a) top fixture front view, b) top fixture top view, c) top fixture
right side view, d) bottom fixture front view, e) bottom fixture top view, and f)
bottom fixture right side view
Using this design, a standard process was implemented for ensuring minimal
parallelism error between the platens of the vacuum grip fixtures. This process was
implemented prior to the start of each experiment involving a bonding process as
described in the main text. First, the adjustment screws are disengaged to allow the
bottom platen to rotate freely (Fig. F5a). Then the two platens are compressed together
on the tensile testing machine. As the platens come into contact, the bottom platen
rotates until parallelism error relative to the top platen is minimized (Fig. F5b).
Engaging the adjustment screws as shown in Fig. Fc then locks this minimum
parallelism error alignment in place. At this point, the tensile tester frame’s z – height
position is tared, ensuring accurate measurement of the gap between the platens during
upper platen motion of the experimental bonding process. Note that the bottom fixture
vacuum intake line is disconnected prior to platen alignment (see Fig. F5a-b) to allow
the bottom platen to more easily rotate into the minimum parallelism alignment.
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a)

b)

c)

d)

Figure F5 – Vacuum grip fixture a) before parallelism adjustment, b) during
parallelism adjustment, c) after fixing minimum parallelism error alignment in place
and taring z – position to correspond with inter-platen gap, and d) after separation to
initial platen start height of experimental bonding process
This adjustable parallelism system also ensures that variations in the threaded
connections between the tensile tester’s base components (frame, load cell, and
stainless-steel compression platens) do not contribute to repeatability error in vacuum
gripper platen parallelism between experimental runs. Prior to implementation of the
universal joint and adjustment screw system, macroscopic variability in parallelism
was often visible between the platens each time they were re-assembled.
One potential limitation of the experimental vacuum grip fixtures is that the
attachment of large vacuum feed tubes to each fixture imposes a significant torque on
the load cell, leading to systematic load reading error (load bias). However, this torque
had no noticeable effect on the universal tester crosshead position or reading, as the
crosshead is a very large and stiff component. This phenomenon can be greatly reduced
by replacing the current vendor – supplied stainless-steel compression platen with a
custom-built hollow metallic platen that supplies a vacuum feed along the load cell
movement axis. Additionally, later experimental setup characterization found that due
to the soft highly non-Newtonian nature of the selected adhesive, even with the 50 N
load cell much of the resulting recorded load profile during the experimental bonding

88

process was below the minimum accuracy limit (0.01 N) recommended by the load cell
manufacturer. Hence accurate characterization of this adhesive’s mechanical stress
behavior would require a much more sensitive load cell. Since only the final cured bond
strength and bond dimensions were of importance in validating the MPD, the load
measurement limitations of this setup were deemed to not be an issue and loading
behavior was not further investigated in this study.
In addition to the vacuum grip fixtures designed for attachment to an existing
universal tensile testing machine, a separate tool was designed and built for fabrication
of future sub-scale ERV devices. This device consists of a large vacuum chuck endeffector attached to a linear actuator assembly, as shown in Fig. F6. As with the
universal testing machine setup, this tool currently lacks a non-contact sensor to detect
the stack height during bonding.

Linear Actuator
Assembly

Vacuum chuck
end-effector

Figure F6 - Sub-scale ERV bonding tool, front view
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The linear actuator assembly enables precise motion control of the vacuum endeffector, and consists of a linear actuator (Misumi LS1004-100-E40-MP2) attached to
a servo motor (Applied Motion M0100-101-3-000) as shown in Fig. F7. This actuator
assembly is connected to a servo motor driver (Applied Motion SVAC3-Q-E120) and
programmed through a controller (Q Programmer) installed on a laptop.

Servo motor

Linear Actuator

Figure F7 - Linear actuator with attached servo motor
As a whole, this actuator assembly has a maximum allowable axial load of 39.1
N (8.8 lbs) based on the maximum thrust load given for the servo motor, and a
positioning repeatability of ±0.02 mm. Additionally, the actuator assembly has a
positioning resolution of 0.0005 mm based upon the actuator ball screw’s 4 mm / rev
lead and servo motor encoder’s 8,000 counts per revolution.
The vacuum chuck end-effector in the sub-scale bonding tool consists of a large
platen attached to a stiff Delrin plate with a series of extension springs, as shown in
Fig. F8. Three thumb screws (Newport PN: 9366) in contact with the top surface of the
platen allow adjustment of the platen parallelism, as shown in Fig. F8b. The platen
itself consists of a vacuum plenum (HPDE with end milled channels for vacuum flow)
and porous fiberboard (Trupan Ultralight MDF ¾” thick, with both faces milled to
expose the porous structure), to enable even distribution of a vacuum load. As shown
in Fig. F9, only the center hexagonal region of the platen’s porous medium is exposed
for application of vacuum load, giving an effective work envelope of 250 mm x 62.5
mm for the full bonding and stretching process described in the main text.
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a)

Delrin plate

Platen

b)

Thumb screw

Extension spring

Figure F8 - Vacuum chuck end effector assembly a) front view and b) close-up of an
adjustment thumb screw
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Figure F9 - Vacuum chuck end effector assembly bottom view
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Appendix G: Experimental Curing Machine Tool Specification
For an experimental curing process tool meant to simulate the manufacturing
machine tool specification, we designed and fabricated a forced convective heater as
shown in Fig. G1.

a)

b)

Figure G1 – Experimental curing process tool a) front view, and b) close-up
underside view with porous air flow window shown. Note the placement of the test
article directly beneath the window for maximal heat control.
To maximize the temperature profile ramp possible with convective heating, it
was determined that a standard commercially available air dryer provided the highest
potential forced convective heat flux while remaining cost effective. A transformer
capable of power adjustment between 0 – 120 VAC was attached to the hair dryer to
allow heat and resulting adhesive temperature profile adjustment.
Although forced convective heating can be cost effective, two major concerns
with this method were air flow maldistribution leading to spatial temperature nonuniformity, and excessive air flow deforming uncured adhesive beads. To overcome
these difficulties, a cardboard enclosure was constructed around the hair dryer mouth
to act as a pressurized heat reservoir. On the bottom surface of this enclosure, a small
window composed of standard commercially available HVAC air filter was added (see
Fig. G1b) with dimensions slightly larger than the 2” x 2” experimental bead profile
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test article footprint. By using a pressurized heat reservoir in conjunction with a thin
porous medium for emission of the heated air instead of direct air flow from the hair
dryer, the air flow rate was reduced, minimizing the risk of peeling away membrane or
deforming the still uncured adhesive. Additionally, the heated air was distributed
evenly directly over the test article, ensuring spatial uniformity of the experimental
curing process temperature profile.
Further calibration and characterization of this tool as described in the
experimental results and discussion portion of the main text showed that the resulting
adhesive temperature profiles demonstrated the spatial temperature uniformity and
repeatability required for a manufacturing curing process. However, the initial heating
ramp was slower than in an ideal heating process, with the final curing process adhesive
temperature more than 10 °C below the maximum allowable adhesive curing
temperature. Hence our experimental tool design was justified as a conservative stand
– in for the manufacturing curing process, resulting in an underestimation of adhesive
curing rate.
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Appendix H: Bond Peel Test Article Dispensing Parameters
Table H1 - Peel test article dispensing parameters
Dispense pressure
Nozzle type
Pre-move delay factor
Down speed
Down accel
Dispense gap
Nozzle scan speed
Shutoff distance
Suckback
Dwell
Backtrack gap
Backtrack length
Backtrack speed
Retract distance
Retract speed
Retract accel

70 psi
None
0.2 s
50.8 mm/sec
7619.996 mm/s^2
1.6 mm
30 mm/s
1.0 mm
N/A
0.5 s
5 mm
50 mm
700 mm/s
5 mm
500 mm/s
15000 mm/s^2
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Appendix I: Experimental Machine Tool Programming Procedure
IA Multilayer Dispensing Process Programming
This dispensing process programming does not include the proper adjustment
of each line’s dispense parameters (scan speed, nozzle to membrane gap, fluid pressure,
etc…). The parameters must be adjusted during dispensing tool setup immediately prior
to test article fabrication.
1. Turn on the 110 psi clean dry air (CDA) or dry nitrogen gas input to the
dispenser. Then turn on the dispenser and connected controller laptop.
2. On the connected controller laptop desktop, double click the “FmXP” icon.
3. On the “FmXP” main menu, click “Teach a Program” (Fig. I1).

Figure I1 - FmXP main menu
4. On the top menu of the programming window, select “File” > “New”. Then
select “Two” as the number of fiducials and press “OK”.
5. On the pop-up window (“Teach first point defining axis”), move the stage until
the crosshair is aligned with the bottom left corner of the PC plate in the camera
image, then press “Teach”.
6. On the pop-up window (“Teach second point defining axis”), move the stage
until the crosshair is aligned with the bottom right corner of the PC plate in the
camera image, then press “Teach”.
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7. On the pop-up window (“Teach workpiece origin”), move the stage until the
crosshair is aligned with the bottom left corner of the PC plate in the camera
image, then press “Teach” and “Done”.
8. On the pop-up window (“Select method to find Fid 1”), select the “Manual
Fiducial” radio button, then press “Next”.
9. On the pop-up window (“Jog to Fid 1, then press Teach…”), move the stage
until the crosshair is aligned with the bottom left corner of the PC plate in the
camera image, then press “Teach”.
10. On the pop-up window (“Select method to find Fid 2”), select the “Manual
Fiducial” radio button, then press “Next”.
11. On the pop-up window (“Jog to Fid 2, then press Teach…”), move the stage
until the crosshair is aligned with the bottom right corner of the PC plate in the
camera image, then press “Teach”.
12. Add the code shown in Fig. I2 to the window. Note that code can’t be typed
directly into the window. Instead, follow steps 13 – 18 to add this code.
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Figure I2 - Dispensing process code for a 5 layer test article
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13. To add the code “FIND SUBSTRATE HEIGHT: (X,Y)”, on the top menu of
the programming window, select “Program” > “Process Commands” > “Find
Substrate Height”. Then type in the desired X & Y coordinates, and press “Go
to”, “Teach” and “Done”. This command tares the nozzle z – position in the
specified location by contacting the substrate with a stiff metal probe.
14. To add the code “MOVE ABS XY: (X,Y)”, on the top menu of the
programming window, select “Program” > “Motion” > “Move Abs X,Y”. Then
type in the desired X & Y coordinates, and press “Go to”, “Teach” and “Done”.
This command moves the dispenser stage to the location (X,Y) with (0,0) being
specified by the fiducials set at the beginning of program execution.
15. To add the code “MOVE ABS Z: (Z)”, on the top menu of the programming
window, select “Program” > “Motion” > “Move Abs Z”. Then type in the
desired Z coordinates, and press “Go to”, “Teach” and “Done”. This command
moves the dispenser nozzle to a specified Z height.
16. To add the code “LINE: #, Start:(X1,Y1), End:(X2,Y2)”, on the top menu of
the programming window, select “Program” > “Line”. Then type in the desired
start point X1 & Y1 coordinates, desired end point X2 & Y2 coordinates, and
select the desired line style from the drop down menu. Then press “Go to” for
both the start point and end point, followed by “Teach” and “Done”. This
command dispenses a line from (X1,Y1) to (X2,Y2) using the parameters
specified by line #. Note that there is no way to directly specify the nozzle – to
– substrate gap in this command.
17. To add the code “PAUSE: <Text>”, on the top menu of the programming
window, select “Program” > “Time Commands” > “Pause”. Then type in the
desired pause <Text>, and press “OK”. This command pauses the program until
the operator presses the “Continue” button on a prompt pop up window during
program operation.
18. To add the code “WAIT: <Duration> second(s) - <Text>”, on the top menu of
the programming window, select “Program” > “Time Commands” > “Wait”.
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Then type in the desired wait time <Duration> and WAIT message <Text>, and
press “OK”. This command pauses the program for a specified time period.
19. Once all code is added to the programming window, on the top menu of the
window, select “File” > “Save As” and then chose a file location. Then save the
dispensing process file as “Multilayer Dispense Process.fmw”.

IB Layer N Bonding Process Programming
This procedure assumes the bonding tool is an Instron 5969 Universal Testing
Frame with Bluehill 3.12.1238 control software (no extensometer attached). Due to the
limitations of this control software version, only a few pre-programmed types of
actuation cycles (called “Methods”) are possible. Hence a separate program had to be
made for each layer of the test article which used different sets of bonding parameters.
Also, the compression and multiple extension ramps of the desired MPD bonding
process could only be achieved in a single program (method) by selecting a “metals”
method and using the “pre-cycle” option with “Capture precycle data” enabled for the
initial compression portion of the process.
To make a separate program for each layer n bonding process, perform the
following procedure for each layer n:
1. Calculate the layer n bonding process parameters [ℎ𝑠𝑡𝑎𝑟𝑡,𝑝 ]𝑛 , [ℎ𝑐𝑜𝑚𝑝,𝑝 ]𝑛,
[ℎ𝑑𝑟𝑎𝑤,𝑝 ], and [ℎ𝑒𝑛𝑑,𝑝 ]𝑛 by inserting the layer number (n), the nominal
membrane thickness (in this case 0.027 mm), measured sample mean single
layer bead height (measured experimentally from single layer test articles), and
remaining parameters in Table 3 & 8 of the main text into Eqn. 9 – 12 of the
main text. For convenience, these are reproduced below:
[ℎ𝑠𝑡𝑎𝑟𝑡,𝑝 ]𝑛 = (𝑛 − 1)(ℎ𝑚𝑒𝑚 + ℎ̅𝑏,𝐿1 ) + ℎ𝑠𝑡𝑎𝑟𝑡,𝑝
[ℎ𝑐𝑜𝑚𝑝,𝑝 ]𝑛 = (𝑛 − 1)(ℎ𝑚𝑒𝑚 + ℎ̅𝑏,𝐿1 ) + ℎ𝑐𝑜𝑚𝑝,𝑝
[ℎ𝑑𝑟𝑎𝑤,𝑝 ]𝑛 = (𝑛 − 1)(ℎ𝑚𝑒𝑚 + ℎ̅𝑏,𝐿1 ) + ℎ𝑑𝑟𝑎𝑤,𝑝
[ℎ𝑒𝑛𝑑,𝑝 ]𝑛 = 𝑛(ℎ𝑚𝑒𝑚 + ℎ̅𝑏,𝐿1 ) + ℎ𝑠𝑡𝑎𝑟𝑡,𝑝
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Initial platen start height, ℎ𝑠𝑡𝑎𝑟𝑡,𝑝

30 mm

Initial platen compression height, ℎ𝑐𝑜𝑚𝑝,𝑝

1 mm

Platen compression speed, 𝑣𝑐𝑜𝑚𝑝,𝑝

240 mm/min

Initial platen draw height, ℎ𝑑𝑟𝑎𝑤,𝑝

1.554 mm

Platen draw speed, 𝑣𝑑𝑟𝑎𝑤,𝑝

15 mm/min

Draw dwell time, 𝑡𝑑𝑤𝑒𝑙𝑙

14 sec

Vacuum release time, 𝑡𝑟𝑒𝑙𝑒𝑎𝑠𝑒

3 sec

Platen return speed, 𝑣𝑟𝑒𝑡𝑢𝑟𝑛,𝑝

600 mm/min

Initial platen end height, ℎ𝑒𝑛𝑑,𝑝

30 mm/min

2. Calculate the following expression:
𝑇𝑖𝑚𝑒 𝑜𝑓 𝑣𝑎𝑐𝑢𝑢𝑚 𝑟𝑒𝑙𝑒𝑎𝑠𝑒 𝑑𝑢𝑟𝑖𝑛𝑔 𝑏𝑜𝑛𝑑𝑖𝑛𝑔 𝑝𝑟𝑜𝑐𝑒𝑠𝑠
=

ℎ𝑠𝑡𝑎𝑟𝑡,𝑝 − ℎ𝑒𝑛𝑑,𝑝 ℎ𝑑𝑟𝑎𝑤,𝑝 − ℎ𝑐𝑜𝑚𝑝,𝑝
+
+ 𝑡𝑑𝑤𝑒𝑙𝑙
𝑣𝑐𝑜𝑚𝑝,𝑝
𝑣𝑑𝑟𝑎𝑤,𝑝

a. The value of this expression represents the target duration between
when the operator starts the bonding process, and when the operator
shuts off the vacuum load.
3. Calculate the following expression:
𝑇𝑖𝑚𝑒 𝑜𝑓 𝑓𝑖𝑛𝑎𝑙 𝑝𝑙𝑎𝑡𝑒𝑛 𝑚𝑜𝑣𝑒𝑚𝑒𝑛𝑡 𝑠𝑡𝑎𝑟𝑡 𝑑𝑢𝑟𝑖𝑛𝑔 𝑏𝑜𝑛𝑑𝑖𝑛𝑔 𝑝𝑟𝑜𝑐𝑒𝑠𝑠
=

ℎ𝑠𝑡𝑎𝑟𝑡,𝑝 − ℎ𝑒𝑛𝑑,𝑝 ℎ𝑑𝑟𝑎𝑤,𝑝 − ℎ𝑐𝑜𝑚𝑝,𝑝
+
+ 𝑡𝑑𝑤𝑒𝑙𝑙 + 𝑡𝑟𝑒𝑙𝑒𝑎𝑠𝑒
𝑣𝑐𝑜𝑚𝑝,𝑝
𝑣𝑑𝑟𝑎𝑤,𝑝

4. Turn on the Instron 5969 frame and controller computer.
5. Double click the “Bluehill 3” icon on the controller computer desktop.
6. On the Bluehill 3 main menu as shown in Fig. I3, double click the “Method”
icon.
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Figure I3 - Bluehill 3 main menu
7. Select “Create Method” from the side menu, then “Metals method” from the
Method template drop-down menu. Click next.
8. Select “Test Control” > “Pre-Test” from the side menu, then input values as
shown in Fig. I4. Then select “Test Control” > “Test” from the side menu and
input values as shown in Fig. I5. Then select “Test Control” > “End of Test”
and input values as shown in Fig. I6. Note that the variable values (red text) are
calculated in steps 1 – 3.
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𝑣𝑐𝑜𝑚𝑝,𝑝
[ℎ𝑠𝑡𝑎𝑟𝑡,𝑝 ]𝑛
[ℎ𝑐𝑜𝑚𝑝,𝑝 ]𝑛

Figure I4 - Layer n bonding process method pre-test screen
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𝑣𝑑𝑟𝑎𝑤,𝑝

[ℎ𝑑𝑟𝑎𝑤,𝑝 ]𝑛

(Time of
vacuum release
during bonding
process)

𝑣𝑟𝑒𝑡𝑢𝑟𝑛,𝑝
(Time of final
platen movement
start during
bonding process)

Figure I5 - Layer n bonding process method test screen
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[ℎ𝑒𝑛𝑑,𝑝 ]𝑛

Figure I6 - Layer n bonding process method end of test screen
9. Select “Exports” > “Pre-Test” from the side menu. Then specify a default file
location for saving recorded time – extension – load data, and default file name.
10. Press “Save As” on the bottom right corner of the method screen, and specify a
location for the saved program (method). Then name the layer n bonding
process program (method) “LayerN_BndProcess”.
a. Substitute the layer number for N; i.e. if the layer 2 bonding process is
being programmed, call the file “Layer2_BndProcess”.

IC Bonding Tool Calibration Programming
1. Turn on the Instron 5969 frame and controller computer.
2. Double click the “Bluehill 3” icon on the controller computer desktop.
3. On the Bluehill 3 main menu, click the “Method” icon.
4. Select “Create Method” from the side menu, then “Compression Relax/Creep”
from the Method template drop-down menu. Click next.
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5. Select “Test Control” > “Test” from the side menu, then input values as shown
in Fig. I7a. Then select “Test Control” > “End of Test” from the side menu and
input values as shown in Fig. I7b.

a)

b)

Figure I7 - Bonding tool calibration method a) test screen and b) end of test screen
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6. Press “Save As” on the bottom right corner of the method screen, and specify a
location for the saved program (method). Then name the program (method)
“ExtensionZeroing”.

ID Bonding Process Initial Platen Start Height Programming
1. Turn on the Instron 5969 frame and controller computer.
2. Double click the “Bluehill 3” icon on the controller computer desktop.
3. On the Bluehill 3 main menu, click the “Method” icon.
4. Select “Create Method” from the side menu, then “Tension” from the Method
template drop-down menu. Click next.
5. Select “Test Control” > “Test” from the side menu, then input values as shown
in Fig. I8a. Then select “Test Control” > “End of Test” from the side menu and
input values as shown in Fig. I8b.
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a)

b)

Figure I8 - Bonding process initial platen start height method a) test screen and b) end
of test screen
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6. Press “Save As” on the bottom right corner of the method screen, and specify a
location for the saved program (method). Then name the program (method)
“ExtensionInitialSet”.
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Appendix J: Single Layer and Multilayer Test Article Fabrication
Procedure
This procedure assumes that the experimental dispensing tool and bonding tool are
already programmed for each layer of the test article being fabricated (see Appendix I:
Experimental Machine Tool Programming Procedure).

JA Dispensing and Bonding Tool Activation
1. Turn on the 110 psi clean dry air (CDA) or dry nitrogen gas input to the
dispenser. Then turn on the dispenser (switch on back panel and green button
on front panel) and connected controller laptop.
2. On the connected controller laptop desktop, double click the “FmXP” icon
3. Turn on the Instron 5969 frame and controller computer.
4. Double click the “Bluehill 3” icon on the controller computer desktop.

JB Bonding Tool Setup
1. Assemble the Universal Testing Machine (Instron 5969 Dual Column Tabletop
Testing System), 50 N load cell (Instron Cat. No. 2530-50N: 50 N Static Load
Cell), and stainless steel platens (Instron Cat. No. 2501-083: Compression
Anvil, 50 mm (2 in) Diameter), as shown in Fig. J1.
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a)

b)

Figure J1 - Universal testing machine a) assembly components and b) final assembly
with compression platens
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2. Attach the vacuum grip fixtures to the top and bottom stainless steel platens
using eight M5 screws, as shown in Fig. J2.

a)

b)

Figure J2 - Universal testing machine assembly with a) top vacuum grip fixture
attached and b) bottom vacuum grip fixture attached
3. On the Bluehill 3 main menu, click the “Test” icon.
4. On the right menu, click “Select Method”. Then select the “ExtensionZeroing”
program created previously (see Appendix IC Bonding Tool Calibration
Programming for details), and click the “Next” button.
5. On the next screen (“Name the new sample”), click the “Next” button. The
Bluehill 3 program should display a test screen similar to Fig. J18.
6. Make sure all adjustment screws and the vacuum line on the bottom fixture is
disconnected (Fig. J3a), then press the start button to execute the program.
7. Once the top platen makes full contact with the bottom platen (Fig. J3b),
reconnect the vacuum line to the bottom fixture and gently turn each adjustment
thumb screw until they are engaged and can no longer turn (Fig. J3c). This
process minimizes the parallelism error between the platens.
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a)

b)

c)

d)

Figure J3 – Vacuum grip fixture a) before parallelism adjustment, b) during
parallelism adjustment, c) after fixing minimum parallelism error alignment in place
and taring z – position to correspond with inter-platen gap, and d) after separation to
initial platen start height of experimental bonding process

8. Press the “Console settings” button (

) on the test screen. Then on the pop-

up screen, select the “Soft Keys” tab and select the “Reset gauge length” soft
key. This should add a large “Reset gauge length” button (

) on

the test screen.
9. Press the “Reset gauge length” button (

) on the test screen to tare

the machine’s crosshead reading to match the gap between platens.
10. Press the “Bluehill” button (

)on the upper left side of the test screen to

return to the Bluehill main menu (Don’t save changes).
11. On the Bluehill 3 main menu, click the “Test” icon.
12. On

the

right

menu,

click

“Select

Method”.

Then

select

the

“ExtensionInitialSet” program created previously (see Appendix ID Bonding
Process Initial Platen Start Height Programming for details), and click the
“Next” button.
13. On the next screen (“Name the new sample”), click the “Next” button. The
Bluehill 3 program should display a test screen similar to Fig. J18.
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14. Press the start button to execute the program.
15. Press the “Bluehill” button (

) on the upper left side of the test screen to

return to the Bluehill main menu (Don’t save changes). The parallelism and gap
between the bonding tool platens should now be properly set for the first
bonding process of test article fabrication (i.e. set to the initial platen start height
of 30 mm).
16. On the Bluehill 3 main menu (bonding tool), click the “Test” icon.
17. On

the

right

menu,

click

“Select

Method”.

Then

select

the

“Layer1_BndProcess” program created previously (see Appendix IB Layer
N Bonding Process Programming for details), and click the “Next” button.
18. On the next screen (“Name the new sample”), click the “Next” button. The
Bluehill 3 bonding tool software should display the test screen shown in Fig.
J18.
19. Load a new membrane (coated side facing down) onto the upper vacuum grip
fixture platen and only turn on the top platen vacuum load, as shown in Fig. J4.

Membrane
(Coating
facing down)

Only top platen
vacuum load (oneway valve) active

Figure J4 - Bonding tool with membrane loaded
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20. The bonding tool show now be ready for immediate start of the first layer
bonding process.

JC Dispensing Tool Setup - Filling Adhesive Syringes
1. Fill a 30 cc syringe barrel with adhesive. In this case this was done by cutting
off the tip of the raw Dow Corning Fast Tack 3165 RTV Adhesive Sealant 1/10
gal cartridge and using a caulking gun to fill the syringe from the bottom, as
shown in Fig J5.

Figure J5 - Filling a 30 cc syringe barrel with adhesive
2. Attach a luer lock nozzle tip (in this case 16 gauge) to the syringe barrel. Then
load the syringe barrel onto the dispenser, as shown in Fig. J6. Note that the
pressured air/gas line is attached to the rightmost silver connector on the
dispenser.
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Figure J6 - Syringe barrel loaded onto dispenser

JD Dispensing Tool Setup - X, Y, and Z Position Calibration
1. On the front panel of the dispenser, turn the grey knob until the fluid pressure
reads <1 psi, as shown in Fig. J7.

Figure J7 - Fluid pressure adjustment knob on dispenser

116

2. On the “FmXP” main menu, click “Run a Program”.
3. On the resulting “Production” window, click “Setup” > “Prompted Setup”.
4. Click “Next” on the “Clear work area”, “Check purge and weight cup”,
“Change purge boot if necessary…”, “Install new needle, shield, etc.” windows,
and “Done” on the “Press [Done] to run the Valve Offset process” window.
5. On the resulting “Machine Setup” window, press “Run to End”.
6. On the “Teach Safe Z height” window, type in 40 for the “Value” text field.
Then press “Go to”, “Teach” and “Done”.
7. On the “For Valve 1 align needle on mark” window, place a patch of silly putty
beneath the nozzle location. Then slowly lower the nozzle z-height until the
nozzle touches / makes a circular impression on the silly putty (Fig. J8), and reraise the nozzle away from the putty. Then press “Teach”.

Figure J8 - Nozzle tip alignment
8. On the “Align camera on needle mark and press [Teach]” window, move the
dispenser stage until the cursor on the camera screen lies in the center of the
mark on the silly putty made by the nozzle, Then press “Teach”.
9. On the “For Valve 1 align probe on mark” window, slowly lower the probe zheight until the probe touches / makes a circular impression on the silly putty
(Fig. J9), and re-raise the probe away from the putty. Then press “Teach”.
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Figure J9 - Dispenser probe alignment
10. On the “Align camera on probe mark and press [Teach]” window, move the
dispenser stage until the cursor on the camera screen lies in the center of the
mark on the silly putty made by the probe, Then press “Teach”.
11. For the remaining prompted setup in the pop up window, follow the prompt in
the windows using all the default options. (Click “no” when the prompt asks if
you are installing a new syringe). This procedure ensures that the dispenser x,
y, and z position are calibrated prior to test article fabrication.
12. Press “Main” (

) to go back to the FmXP main menu.

JE Dispensing Tool Setup - Calculating Nozzle Scan Speed
1. On the front panel of the dispenser, turn the grey knob until the fluid pressure
reads 70 psi.
2. On the FmXP main menu, click “Configuration” > “Setup Purge Station”.
3. Make sure the “Timed Purge” box is unchecked, then press purge. Observe the
stream of adhesive coming out of the nozzle, and press “Cancel” on the pop up
window to stop the purge when the stream looks consistent (no obvious
“chunks” or “kinks”).
4. In the Purge duration text field, type 6 sec. Then check the “Timed Purge” box.
5. Press “purge”, and after the 6 sec purge measure the resulting mass in the purge
cup.
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6. Repeat the previous step four more times.
7. Calculate the ideal experimental nozzle scan speed 𝑣𝑠,𝑒𝑥𝑝𝑡 based on the average
measured mass 𝑚
̅ 𝑝𝑢𝑟𝑔𝑒 in mL from the five purge cycles and Eqn. 7 in the main
text (reproduced below for convenience):
4

𝑣𝑠,𝑒𝑥𝑝𝑡 = 𝜋𝐷2 ∗

̅ 𝑝𝑢𝑟𝑔𝑒
1000∗𝑚
𝑡𝑝𝑢𝑟𝑔𝑒 ∗𝜌𝑎𝑑ℎ

(J1)

Where 𝑡𝑝𝑢𝑟𝑔𝑒 is the purge duration (6 seconds), 𝜌𝑎𝑑ℎ is the adhesive mass (in
this case 1.35 g/mL), and 𝐷 is the nominal nozzle tip inner diameter (in this
case 1.2 mm).

JF Dispensing Tool Setup – Initializing Parameters and Program
1. Calculate each layer n dispensing process nozzle to membrane gap [ℎ𝑛𝑜𝑧 ]𝑛 by
inserting the layer number (n), the nominal membrane thickness (in this case
0.027 mm), measured sample mean single layer bead height ℎ̅𝑏,𝐿1 (measured
experimentally from single layer test articles), and initial nozzle to membrane
gap ℎ𝑛𝑜𝑧 of 1.2 mm into Eqn. 8 of the main text. For convenience, this equation
is reproduced below:
[ℎ𝑛𝑜𝑧 ]𝑛 = 𝑛ℎ𝑚𝑒𝑚 + (𝑛 − 1)ℎ̅𝑏,𝐿1 + ℎ𝑛𝑜𝑧

(J2)

1. On the FmXP main menu, click “Teach a Program”. Then on the top menu of
the programming window, click “File” > “Open”.
2. Open the “Multilayer Dispense Process.fmw” program previously
programmed

(see

Appendix

IA

Multilayer

Dispensing

Process

Programming for details)
3. On the top menu of the programming window, click “Edit” > “Edit Line
Parameters”. Then set each line according to the parameters shown in Fig. J10
– J12 followed by pressing “Apply” and “OK”. Note that the variable values
(red text) are calculated in Eqn. J1 and J2 of this appendix.
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Figure J10 – FmXP “Pre-Dispense” line parameters

[ℎ𝑛𝑜𝑧 ]1

𝑣𝑠,𝑒𝑥𝑝𝑡

[ℎ𝑛𝑜𝑧 ]2
[ℎ𝑛𝑜𝑧 ]3
[ℎ𝑛𝑜𝑧 ]4
[ℎ𝑛𝑜𝑧 ]5

Figure J11 – FmXP “During Dispense” line parameters
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Figure J12 – FmXP “Post Dispense” line parameters
4. Start the multilayer dispensing process in the FmXP program and follow the
prompts for fiducial alignment with the bottom left and bottom right corners of
the 1.1 mm thick PC substrate. When the program displays a PAUSE pop up
window prompting for the user to “Clean Nozzle Tip”, as shown in Fig. J13a,
gently insert a wire into the nozzle and move it in an up and down motion as
shown in Fig. J13b, then press “Continue”. This was done to get rid of the buildup of any adhesive cured surface skin on the nozzle tip, as this can cause defects
in the first few beads of the dispensed test article adhesive pattern.
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a)

b)

Figure J13 - Dispenser nozzle cleaning a) FmXP software prompt and b) procedure
5. When the program displays a PAUSE pop up window prompting for the user to
“INSERT SAMPLE”, as shown in Fig. J14a, place a new 2” x 2” membrane
onto the 1.1 mm thick PC substrate on the dispenser stage with the coated side
facing upwards, as shown in Fig. J14b. The PC substrate should have enough
static electricity to hold down the membrane without any tape. If not, rub the
PC with a felt cloth until the membrane is able to stick in place even when the
stage moves. By the end of this step, the dispensing tool show now be ready for
immediate start of the first layer bonding process.
6. Press “Continue” to begin the first layer dispensing process, then proceed to the
next section
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a)

b)

Figure J14 - Bottom test article membrane loading a) FmXP software prompt and b)
procedure

JG Layer N Lamination
Perform the following procedure for each layer n in the test article. To ensure that
the required takt time 𝑡𝑡𝑎𝑘𝑡,𝑟𝑒𝑞 (in this case 54 sec) is maintained between the start of
each process step, a stopwatch is used which is reset / restart at the start of each process
step (dispensing, bonding, and curing).
1. At the moment the dispensing tool program automatically begins depositing
layer n’s first adhesive bead (example after three beads deposited shown in Fig.
J15), reset / restart the stop watch. This starts the Layer n dispensing process,
and resets the elapsed takt time to 0 sec.
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a)

b)

Figure J15 - Test article during pre-programmed dispense process from a) front
perspective and b) close detail perspective
2. After the pre-programmed dispensing process finishes, the test article will
automatically be presented as shown in Fig. J16a, and the FmXP dispenser
software screen will display the PAUSE screen as shown in Fig. J16b.
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a)

b)

Figure J16 - End of the pre-programmed dispensing process a) test article location
and b) FmXP dispenser program PAUSE screen
3. Move the test article to the bonding tool as shown in Fig. J17, then activate both
the top and bottom platen vacuum loads.
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Both vacuum
loads (oneway valves)
active

Figure J17 - Test article loaded onto the bonding tool prior to the start of the
bonding process
4. Once the stop watch reads 54 seconds, simultaneously press the start button on
the universal testing machine to execute the program and reset / restart the
stopwatch. This starts the Layer n bonding process, and resets the elapsed
takt time to 0 sec.
5. Immediately place the stop watch next to the dispenser stage and then observe
the large time tracker at the top right of the Bluehill 3 bonding tool test screen,
as shown in Fig. J18. When the time equals the “Time of vacuum release during
bonding process” calculated in step 2 of Appendix IB Layer N Bonding
Process Programming (in this case approximately 23 sec), shut off both
vacuum line valves on the bonding tool.
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Figure J18 - Bluehill 3 screen during bonding process
6. Move the test article from the bonding tool as shown in Fig. J19a to the
dispenser stage with the curing tool moved to the side as shown in Fig. J19b.

a)

b)

Both vacuum
loads (oneway valves)
inactive

Figure J19 - End of the bonding process test article location a) before removing from
bonding tool and b) after moving to dispenser stage.
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7. Move the curing tool into position over the test article as shown in Fig. J20. In
this case, tape was used to mark off the correct tool position for repeatability
between curing cycles.

Porous curing
tool heating
window

Test article
Tape
Figure J20 - Location of curing tool during operation
8. Once the stop watch reads 54 seconds, simultaneous press “Continue” on the
PAUSE pop up window on FmXP dispenser software and turn on the curing
tool, as shown in Fig. J21. This starts the Layer n curing process, and resets
the elapsed takt time to 0 sec. The pre-programmed dispenser program
will automatically move the test article through the Layer n curing and
dispensing process steps.
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FmXP dispenser
software PAUSE
pop up window

Curing tool start button (Variac)

Figure J21 - Test article location and FmXP dispenser software screen at the start of
the curing process
9. Prepare the bonding tool for the next layer (n + 1) fabrication while the FmXP
software is performing the curing process on the test article:
a. Press the “Bluehill” button (

) on the upper left side of the

Bluehill 3 (bonding tool) test screen to return to the Bluehill 3 main
menu (Don’t save changes).
b. On the Bluehill 3 main menu (bonding tool), click the “Test” icon.
c. On the right menu, click “Select Method”. Then select the
“LayerN+1_BndProcess” program created in the Appendix IB Layer
N Bonding Process Programming, and click the “Next” button.
i. N + 1 = n + 1 = the next layer being fabricated (i.e. if the current
layer being fabricated is layer 1, choose Layer2_BndProcess).
d. On the next screen (“Name the new sample”), click the “Next” button.
The Bluehill 3 bonding tool software should end up on the screen shown
in Fig. J18.
e. Load a new membrane onto the upper vacuum grip fixture platen and
only turn on the top platen vacuum load, as shown in Fig. J4.
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i. If n + 1 (the next layer being fabricated) is even, load the
membrane with the coated side facing up; if n + 1 is odd, load
the membrane with the coated side facing down.
10. Observe the test article on the dispensing stage, and wait for the layer n + 1
(next layer) dispensing process. When the curing process step is done, turn off
the curing tool. Go back to step 1 of this appendix subsection to begin the next
layer fabrication.

JH Post Fabrication Cure
1. Place the fabricated n layer test article into a natural convective oven for 3 hrs.
(set at 50 °C for this particular adhesive), as shown in Fig. J22.

Figure J22 - Post fabrication curing oven
2. Remove the cured test article from the oven and allow to cool to room
temperature.
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Appendix K: Possible Sources of Peel Strength Test Error
Although observed peel strength is taken as a direct indication of the amount of
force that can act on the perimeter of adhesive bonds within the ERV during operation
before bond failure, there are a few potential sources of error which potentially affect
interpretation of the results. First, bond thickness and width is not perfectly uniform
and may lead to both peel load variability and uncertainty in the calculated average peel
strength. Given that bond width in each test article was assumed to be uniform despite
having inherent variability, the calculated bond peel strength for each test article has a
degree of uncertainty which is not captured in the data analysis. This uncertainty cannot
be fully determined without an accurate and precise measurement of the full bond width
distribution within each test article. A second factor which complicates interpretation
of peel test results in the context of ERV performance is the physics of the bond peeling
process itself. Past studies have noted that the weight of peel test articles can affect the
measured load and cause asymmetry of peel behavior during testing, resulting in an
overestimation in average measured peel force and fracture toughness [34]. This
peeling asymmetry was visible during testing, as depicted in Fig. 22 in the results and
discussion section of the main text.
Because of the induced asymmetry, this effect cannot simply be eliminated by
subtracting sample weight from the measured load curve, and common methods for
minimizing both effects which prescribe manual hand support of the bonded tail to hold
it perpendicular to the axis of grip motion have the potential to induce operator handling
error on test results [34]. One recently demonstrated solution for minimizing the effect
of sample weight and peel asymmetry without introducing operator handling error is
the implementation of a platform which is designed to move at half the speed of grip
separation during peel testing. This allows the bonded ungripped end of the test article
to rest in the ideal T-peel position throughout the duration of a test without being
subjected to extraneous external forces [34].
Additionally, once the test is properly designed to ensure ideal peel physics
occurs throughout the test duration, further work is needed to correlate measured peel
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strengths with the actual forces experienced during bond separation in the proposed
ERV design.
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Appendix L: Future Work
Future investigations will likely involve the selection and testing of other
classes of adhesives to find a combination of adhesive materials and MPD parameters
which satisfy all process and material requirements. To improve the experimental
process control, several improvements may be implemented. Currently, bonding platen
parallelism contributes significantly to observed test article bead height variability
within each layer. Since the minimal achievable parallelism between two platens is
affected by each platen’s flatness, one possible solution for reducing platen parallelism
error is to replace the manually sanded fiberboard platens with precision machined
platens made from a stiff porous material.
Another major source of uncontrolled error in the experimental procedure is the
potential for handling to deform bonded layers and induce bead height variability as
test articles are moved between experimental machine tools. To avoid the need for
operator handling during fabrication, an integrated bonding tool which makes use of
the same gantry stage as the dispensing tool can be implemented. One such tool was
designed and built as described in Appendix F during preliminary study of the proposed
manufacturing process. However, this tool was not implemented during MPD
validation experiments due to a lack of adequate parallelism control during the first
layer of the test article fabrication process. Implementation of the same parallelism
adjustment mechanism as used in the experimental vacuum grip fixtures may enable
this tool be to be used in future studies. Lastly, repeatability of bond test results may
be improved by implementing the moving peel test fixture described by Padhye et al.
[34].
Another possible avenue for future studies is the development of a constitutive
mechanical model for the uncured and partially cured adhesive to enable Finite Element
Analysis (FEA) of the multilayer bonding process. To enable accurate characterization,
a suitably sensitive bonding tool load cell and a method for characterizing the gradient
in mechanical behavior throughout the depth of a partially cured adhesive bead is
required. As mentioned in Appendix F, it is likely that the custom vacuum grip fixture
for the experimental bonding tool would also need to be redesigned to avoid induced
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error on the measured load as well. In particular, the vacuum feed lines (See Fig. F1)
for this fixture would need to be redesigned so that imposes minimal torque / non axial
load on the load cell during the bonding process. One goal of such modeling would be
to determine whether there is a set of more fundamental quantitative material
parameters which determine whether a given adhesive will meet the Relaxation Rate
and Curing Rate material requirements, since these properties are currently only
defined in terms of the manufacturing process and must be evaluated through complete
experimental simulation of the MPD. This would be analogous to the way that other
well established manufacturing processes might require a workpiece material to have a
certain elastic modulus or Poisson’s ratio. Another goal of FEA modeling would be to
predict the observed oscillation of bead height between layers when 𝑡𝑐𝑢𝑟𝑒,𝑎𝑑ℎ > 𝑡𝑐𝑢𝑟𝑒,𝐿 .
Similar models may also be developed to correlate the peeling forces experienced
during ERV operation with the forces during standardized peel testing, in order to more
accurately determine the required peel strength and peeling method for MPD
validation.

